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What’s New

Overview

SAS/ACCESS 4.2 Interface to R/3 has the following new features and enhancements:
O simplified logon process

0 enhanced authorization checks

enhanced RFC server

enhanced creation of an RFC server destination

new RFC server options

new %CALLRFC macro

new Unicode support for SAS servers

new SAP transport files for simplified ABAP installation

new SAP LIBNAME engine

These changes are from SAS/ACCESS 9.1 Interface to SAP 9.1 and later. For

information about changes to SAS Data Surveyor 4.2 for SAP, see the What’s New
Section in SAS OnlineDoc.

O 0o o o oo d

Simplified Logon Process

In previous versions, you were required to enter CPI-C parameters in the logon
utility when you log on to your R/3 system. You no longer need to use these parameters.
You can instead enter your logon parameters in the Logon to R/3 and Advanced
Parameters windows. For more information, see Using the Logon Utility.
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Enhanced Authorization Checks

You can develop alternative authorization schemes for reading R/3 tables by using
enhanced authorization checks through the /SAS/AUTHO1 Business Add-In (BAdI). By
default, this BAdI performs the same authorization checks as it did previously on
S_TABU_DIS, so no further action is necessary.

Enhanced RFC Server

The command-line syntax for the RFC server supports two operation modes for
extracting data from your SAP R/3: UNIX and Windows NT. For more information, see
“Using the RFC Server on UNIX” on page 58 and “Using the RFC Server on Windows
NT” on page 62.

Enhanced Creation of an RFC Server Destination

simpler process for creating an RFC server destination for a small SAP configuration

Beginning with 4.1, you can omit gateway information when creating an RFC server
destination for a small SAP configuration. For more information, see “Using the RFC
Server in Batch Mode” on page 64.

New RFC Server Options

The following RFC server options are new:

-b
[for 4.1] enables batch compatibility so that you can process V8 ACCR3 requests
using a V9 RFC server.

-B
[for 4.1] boosts performance when you use it to increase the minimum buffer size
for data transfers.

-S
[for 4.2] registers the SAS RFC server at an SAP gateway, enabling it to receive
requests for information from the SAS RFC Server Monitor in the SAP Netweaver
Portal.

For more information about the RFC server, see Chapter 5, “Using the RFC Server,”
on page 57.

New %CALLRFC Macro

You can call RFC-enabled ABAP functions by using the new CALLRFC procedure,
which the %CALLRFC macro uses internally. The CALLRFC procedure uses the RFC
server to communicate with the SAP system. For more information, see “CALLRFC”
on page 66.
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New Unicode Support for RFC Servers

SAS/ACCESS 4.2 Interface to R/3 and later supports Unicode SAP servers on
Windows and UNIX. For details about UNIX platform support, see the Installation
Instructions for SAS/ACCESS Interface to R/3. For information about starting a
Unicode RFC server, see “Using the RFC Server on UNIX” on page 58 and “Using the
RFC Server on Windows NT” on page 62.

New SAP Transport Files for Simplified ABAP Installation

To simplify installation of the required ABAP function modules and programs, it is
recommended that you import the SAP transport files rather than installing these
manually. For more information, see the Installation Instructions for SAS/ACCESS
Interface to R/ 3.

As a result of this change, the new RFC server and RFC dialog server no longer use
the following ABAP function modules and programs:

O Z_SAS_BATCH_INTERFACE 4

O Z_SAS _READ TABLE CPIC

O ZSASRDBT

0O ZSASRDTB

Note: Because the transport files for the SAS/ACCESS 4.2 Interface to R/3 require
different ABAP function modules and programs than the transport files for the SAS/
ACCESS Interface to SAP BW, be sure to use the correct files when you install your
application. A

New SAP LIBNAME Engine

The new SAP LIBNAME engine is a read-only engine that you can use to access
tables and views from SAP R/3 and SAP BW systems. It accesses an SAP system
through a connection to the SAS RFC server and is part of the SAS solution to access
data in an SAP system. It supports new features such as load balancing, user
validation at logon, more efficient handling of projections, server-side joins, and
directory processing.

Unlike other LIBNAME engines in SAS, these interfaces are read-only and do not
support any forms of data set creation, deletion, or modification.

For more information about the new SAP LIBNAME engine, see “Overview of the
LIBNAME Engine for SAP” on page 79.
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CHAPTER

How to Use This Document

Introduction 1
Audience 1

Introduction

SAS/ACCESS® 4.2 Interface to R/3: User’s Guide describes SAS/ACCESS Interface
to R/3 from SAP AG. It provides primary support for SAS/ACCESS 4.2 Interface to R/3.

Audience

This document is intended for applications programmers and other users who are
comfortable with their own operating environment and are reasonably familiar with
either SAS or with R/3. It is assumed that users are completely unfamiliar with using
both of the systems together. The glossary provides definitions of terms that might be
new to a user who is unfamiliar with either system.

This document provides tutorial instruction for a novice user of SAS/ACCESS
Interface to R/3. After you have mastered the tutorial, you can use this document for
reference.
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Exporting R/3 Metadata to SAS/Warehouse Administrator 1

Introduction

This chapter provides a brief introduction to SAS/ACCESS Interface 4.2 to R/3. For
more detailed information, consult the references that are listed in “Recommended
Reading” on page 101 or contact your SAS Support Consultant.

Getting Started with SAS/ACCESS Interface 4.2 to R/3

This section provides a brief tutorial on how to use SAS/ACCESS Interface 4.2 to R/3.
For more detailed information, consult the additional references that are listed in
“Recommended Reading” on page 101 or contact your SAS Support Consultant.

To get started with SAS/ACCESS Interface 4.2 to R/3:

1 Open a SAS session.
2 Enter $r3access in the command line to start SAS/ACCESS Interface 4.2 to R/3.
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Display 2.1 SAS/ACCESS to R/3 Window

¥ SAS/ACCESS to R/3 I [=] E3

£ o O

Datamodel =earch List of
Explorer Metadata Fi3 Tahles
= |
@ = @
Logon Local Lizt of Ri3

=etup Dezcriptors

Wizard to
Load Metacata

L
1| | b

3 Double-click the Logon icon to open the Logon to R/3 window.

Display 2.2 Logon to R/3 Window

l"_"E,_ Logon to R/3: S I=] E3
Profile: | =] Ok
Cliert: | Cancel
=zer IC: I Aclyanced...
Paszword: I Save
Language: | | Help

Existing pre-defined profiles are available from the Profile field drop-down list.
To use a pre-defined profile:

a Select a profile from the Profile field drop-down list.
b Click to connect to R/3.
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If there are no pre-defined profiles, you will need to create one.
To create a new profile:

a Open the Logon to R/3 window as described earlier.

b If you want to save the connection information for later use, enter a name for
the Profile.

Enter a three-digit identification number for the R/3 client.

Enter a valid R/3 user 1ID.

Enter the corresponding R/3 Password for the user ID.

Click in the Logon to R/3 window to display the Advanced
Parameters window that is shown in Display 2.3.

-0 o

Display 2.3 Advanced Parameters Window

I'_‘;Er Advanced Parameters [ [O] =]

General ]Tcpnp | rFe]

Lo |
. cancel |
Connection Id: | IDES |

Helg

Remate: I LOCAL- j

Description;

g From the TCP/IP tab, enter the RFC server name in the Host field. The
default is localhost; a fully qualified domain name might not be required,
depending on the DNS configuration for the network. Enter an appropriate
port number in the Port field.

h From the RFC tab, enter the host name in the Host field.

i Click to close the Advanced Parameters window and return to the Logon
to R/3 window.

j If you want to use this log on information later, click to save the profile
information.

k Click to connect to R/3.

Searching R/3 Metadata

SAS/ACCESS Interface 4.2 to R/3 provides a robust search capability that you can
use to search your metadata for specific information.
For example, to search for all tables that contain the word “scrap” in their metadata:

1 From SAS, start SAS/ACCESS Interface 4.2 to R/3 to display the SAS/ACCESS to
R/3 window that is shown in Display 2.1.

2 Double-click the Search Metadata icon to display the Data Dictionary Search
Facility window.
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Display 2.4 Data Dictionary Search Facility Window

l"_il_ Data Dictionary Search Facility

Search String ]Options ] Search |

I Reset Al |

Encdl

Help |
Reset String |

MName Dlescription | Type il Select |
-
LI F

3 Click inside the text entry field on the Search String tab, and then enter text to
search for, such as the word “scrap”. Click [Search]. A list of tables will display in
the table in the bottom of the Search String tab as shown in Display 2.5.

Display 2.5 Data Dictionary Search Facility Window (Searching for ‘scrap’)

Iiil_Dala Dictionary Search Facility

Search String lOptionS ]

Reset Al |
sCcrap

Encl

Help |

Reset String |

Mame [escription | Type il Selact |
ETMALFT | CCH reazons for scrap TABLE

E2MaALFT | CCR reazons for ecrap TABLE
EMALF‘I CCH reazong for scrap TARLE 'l
4 F

4 Double-click one of the tables in the list. The General Attributes for a List of
Tables window displays to give you more detailed information about the selected
table as shown in Display 2.6.
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Display 2.6 General Attributes for a List of Tables Window

5 Click to return to the Data Dictionary Search Facility window.

Exporting R/3 Metadata to SAS/Warehouse Administrator

SAS/ACCESS Interface 4.2 to R/3 enables you to export metadata from R/3 tables to
a warehouse environment in SAS/Warehouse Administrator.
To export R/3 metadata:
1 From SAS, open SAS/ACCESS Interface 4.2 to R/3 to display the SAS/ACCESS to
R/3 window that is shown in Display 2.1.
2 Double-click the Datamodel Explorer icon to display the Datamodel Explorer
window.
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Display 2.7 Datamodel Explorer Window

3 For this example, click the plus sign (+) for the application data models topic in
the Datamodel Explorer. Then, click the plus sign (+) beside the Industry
Solutions and Industry Solutions Public Sector subtopics. Single-click ISPS_HR
IS-PS Human Resources to select this subtopic.

4 From the main menu of the Datamodel Explorer window, select File » Export
Metadata » SAS/Warehouse Administrator as shown in Display 2.8 to display the
SAS/ACCESS to R/3: Export Metadata to SAS/Warehouse Administrator window.

Display 2.8 File Menu for the Datamodel Explorer Window

Properties

E wport Metadata S45 M arehouze Administrator..
545 Datazets. ..

A Import Data..
" Export Data...

=] Send Mail...

Cloze

Euit
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Display 2.9 SAS/ACCESS to R/3: Export Metadata to SAS/Warehouse Administrator Window

Iiil_ SAS/ACCESS to Rf3: Export Metadata to SAS/ W arehouse Administrator

G
Data Warehouse Environment: I j _.l 4I
Cancel |
COperational Data Groug: I j . | Help |

Select Typels) of Metadats to Export:
W Tahle Metadsta

v Table and Column Metadsts

[ Including Long Description

—Howy to Handle Existing Metadata
* Add ODD

" Update O0Ds

" Overwrite ODDs

From the pata Warehouse Environment drop-down list, select a pre-defined
environment from the SAS/ACCESS to R/3 folder.

From the Operational Data Group drop-down list, select an operational data
group from the selected data warehouse environment. The Operational Data
Group field is disabled until you select a data warehouse environment.

Click to export the metadata to the selected data warehouse environment in
SAS/Warehouse Administrator.
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Introduction

This chapter describes the methods you can use to access R/3 data: direct access and
ODBC, which do not require the use of the interface, and SAS/ACCESS Interface 4.2 to

R/3.
The chapter also includes an overview of the Remote Function Call (RFC) and extract
management methods.

Accessing Data Using Direct Access and 0DBC

There are two methods of accessing data that do not require SAS/ACCESS Interface
4.2 to R/3: direct access and ODBC.

O Direct Access

This is a form of transparent access that does not require additional
programming or intermediate operations. This form of access is possible because
the R/3 system is an Open Systems-compliant application.

Direct access uses an intermediate SAS/ACCESS product to the specific
database, which can be ORACLE, INFORMIX, ADABAS, or DB/2.

o ODBC (Open Data Base Connectivity)

This method allows direct data access in a PC environment by using SAS/
ACCESS Interface to the ODBC.

Accessing Data Using SAS/ACCESS Interface 4.2 to R/3

You can use SAS/ACCESS Interface 4.2 to R/3 to access R/3 data by using two
different methods: Remote Function Call (RFC) or extract management.
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o0 Remote Function Call

The Remote Function Call method is normally used. It offers online access to
the R/3 data.

o Extract Management

The extract management method is the original method that has now largely
been superseded. It offers off-line access to the R/3 data that can be useful when

O there is a poor or slow communication link between SAS and R/3
O a backup file is required

O there is a lot of data.

Note: Both methods generate a SAS DATA step. 2

Remote Function CGall (RFC) Method

The Remote Function Call (RFC) is a SAP AG implementation of the Remote
Procedure Call. RFC allows access to R/3 from external applications, such as SAS or
other R/3 systems.

An overview of the Remote Function Call method for accessing data from R/3 is
shown in Figure 3.1. Two modules (ABAP Function and ABAP Report, which are
provided with the interface) attach to the R/3 system. Communication between the
ABAP Function module and the interface itself uses RFC. On the other side, the
interface uses TCP/IP to communicate with the RFC Server. For more details about the
RFC Server, see Chapter 5, “Using the RFC Server,” on page 57.

Figure 3.1 Remote Function Call (RFC) Method of Accessing Data from the R/3
system

4 ) .
Host 1 SAS Client

4 R/3 System )

TCP/IP
o SAS Views

SAS RFC
Server

ABAP/4
Function

Graphic User
Interface

ABAP/4
Report

Metadata
Extract

Operational
Data
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In general, the RFC method consists of generating a SAS DATA step to access the R/
3 data, and then it uses the DATA step to create either

O a data set that is a SAS copy of the R/3 data
O a View that reads the R/3 data each time it is required.

Extract Management Method

The extract management method creates an ABAP query that copies the data from
R/3 to an external file. It also creates a SAS DATA step that then reads the external file
into SAS. After the R/3 data has been exported to SAS, the data can be held either
temporarily for discrete analysis or permanently in a SAS data warehouse. The
interface generates all of the necessary programs for both ABAP and SAS (based on the
R/3 data dictionary tables).

The extract management method to access R/3 data is discussed in the following
sections: Installation and Setup; Data Transfer and Use.

Installation and Setup

1 Generate an ABAP report.

Use the descriptor file to create an ABAP report and write it to a text file. The
ABAP report is used later to copy the R/3 data to an external intermediate data
file.

2 Generate a DATA step.
Generate a SAS DATA step to read the intermediate data file.
3 Install the ABAP report in R/3.

This step is independent of SAS/ACCESS Interface 4.2 to R/3 and SAS, and you
can perform it simultaneously with Step 2.

4 Install the ABAP text file from Step 1 into R/3.

Data Transfer and Use

Note: After installation and setup, you can perform the following steps as many
times as required. A

1 Run the ABAP report in R/3.

Run the installed ABAP report on R/3. This creates the external intermediate
data file.

2 Use the DATA step.
Use the DATA step to read in or copy the external intermediate data file into
SAS.

Note: Depending on your situation, it might be possible to simplify or streamline
the outlined process. For example, in UNIX a named pipe or other external file
can enable ABAP to write data to the external intermediate data file so that SAS
can read it simultaneously. A
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Introduction

SAS/ACCESS Interface 4.2 to R/3 is an interactive application that supports data
extraction from the R/3 data tables and stores this data in SAS data sets. It simplifies
the process of issuing ABAP queries and executing the SAS DATA step for reading the
R/3 tables.

This chapter outlines the pull-down menus and various windows in SAS/ACCESS
Interface 4.2 to R/3. Several tasks are included with the window that is most closely
associated with that task.

Using the Logon Utility

You use the logon utility to connect to the R/3 system. You can save connection
settings in profiles and then reuse them at a later time.

Logon to R/3 Window

Follow these steps to open the Logon window:
1 Go to the SAS desktop, and open the SAS/ACCESS to R/3 desktop.
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Display 4.1 SAS/ACCESS to R/3 Desktop

¥ SAS/ACCESS to R/3 P [=] B3

Datamodel zearch Lizt of
Explorer Metadsta RJi3 Tahles
= | r—
%! =i
Logon Local List of Ri3
=etup Dezcriptors

Wizard to
Load Metadata

[:I
1| | 3

2 Double-click the Logon icon to open the Logon to R/3 window.

Display 4.2 Logon to R/3 Window

= Logon to R/3: M=] E3
Profile: | | Ok |
Clignt: | Cancel |
Lser IC: | Aovanced... |
Pasaward: I Save |
Langusge: ||

Help |

The Logon to R/3 window has multiple elements that you must specify to log on
successfully.
The Logon to R/3 window contains the following fields:

Profile displays the text label that you assign to the profile that is defined
in this window and the Advanced Parameters window.

Client displays the R/3 client identification number. The client ID must be
three numeric characters with zeros as filler. For example, 10 will
fail but 010 also works.

User ID displays the R/3 user ID.
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displays the R/3 system password.

determines the human language in which to display R/3 data. For
example, entering the letter E in this field sets the language as
English, entering D sets the language as German, and so on. The
text and help screens display in the chosen language as long as
language support is installed.

The Logon to R/3 window contains the following buttons:

logs on to the R/3 system by using the user-supplied information in
the fields.

closes the Logon to R/3 window without trying to log on to R/3.

saves the user-specified information from the fields of the Logon to
R/3 window in the profile.

displays the Advanced Parameters window, which is described in
“Advanced Parameters Window” on page 19.

displays the SAS Help for the Logon to R/3 window.

Logon to R/3 File Menu

Opening the Logon to R/3 window changes the File menu on the main SAS window
and adds a Connections menu. The File menu contains the following commands:

Display 4.3 File Menu

of the Logon to R/3 Window

e Chrl+M
Save Chrl+5
Save Az,

Delete

A Import Data..
" Export Data...

=] Send Mail...

Cloze

Euit

New

Save

Save As

clears the fields in the Logon to R/3 window.

saves the user-specified information from the fields of the Logon to
R/3 window in the profile.

displays the Save As window. This window allows you to enter a
libref name in which to save the profile.



Delete
Import Data
Export Data

Send Mail

Close

Exit
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Display 4.4 Save As Window

Save As

Save Profile.

Libref:

]
I—
(] Cancel |

deletes the profile that is shown in the Logon to R/3 window.
displays the SAS Import Wizard.
displays the SAS Export Wizard.

Opens the standard SAS mail window to let you distribute electronic
mail from SAS.

closes the Logon to R/3 window and returns you to the SAS/ACCESS
to R/3 desktop.

ends the SAS session and closes all open SAS applications.

Logon to R/3 Connections Menu

Opening the Logon to R/3 window also adds the Connections menu.

Display 4.5 Connections Menu of the Logon to R/3 Window

Logon ta BA3...

Lizt Connectionz

Logoff

The Connections menu contains the following items:

Logon to R/3

List
Connections

Logoff

logs on to R/3 by using the user-supplied information in the fields.

displays the List of Connections window that is shown in Display
4.21 on page 33.

disconnects the current logon from R/3.

Advanced Parameters Window

The Advanced Parameters window contains tabs that you can use to define
additional R/3 connection information. While all required fields have default values, not
all fields display those default values.
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Click in the Logon to R/3 window to display the Advanced Parameters
window. The Advanced Parameters window contains these tabs: General, TCP/IP, and
RFC.

Display 4.6 Advanced Parameters Window

I'_‘;Er Advanced Parameters [ [O] =]

General | TcPiP | RFC | LI

cancel |

Connection Id: | IDES |
Remate: I LOCAL- j i

Description;

The Advanced Parameters window contains the following buttons:

closes the Advanced Parameters window and returns you to the
Logon to R/3 window, saving your entered information.
closes the Advanced Parameters window and returns you to the

Logon to R/3 window without saving any change that you might
have made to the fields in the window.

displays the SAS Help for the Advanced Parameters window.

General Tab

When the Advanced Parameters window displays, the General tab is selected by
default. This tab contains general connection information in the following fields:

Connection Id displays a text name that you assign for the connection ID. The
connection ID is used for filerefs and macros in the SAS program to
manage the connection to R/3 and to access the R/3 tables. The
name must follow standard SAS syntax.

Remote displays the remote SAS session. So that R/3 tables can be read into
SAS DATA sets on a remote SAS session, you must establish a
connection to R/3 in a remote SAS session.

Description displays a text description of the connection profile.
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TCP/IP Tab

The TCP/IP tab contains network address information. To display this tab, select it
in the Advanced Parameters window.

Display 4.7 TCP/IP Tab of the Advanced Parameters Window

I'_‘irAdvanced Parameters [ [O] ]

General TGRIP ]RFC] Ok |
Cancel |
Host: | localhost
Help |
Part: I F991

This tab contains the following fields:

Host specifies the network location of the RFC server. The default is
localhost. A fully qualified domain name is not required. For
example, if the RFC server can be reached by using the DNS name
rfc.example.com and is on the local area network, the Host field
accepts either rfc or rfc.example.com. It also accepts numeric
addresses.

Port specifies the TCP/IP port to use for communicating with the RFC
server. The default port number is 6991.
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RFC Tab
The RFC tab contains information that the RFC server uses to connect to the SAP R/3
application server. To display this tab, select it in the Advanced Parameters window.

Display 4.8 RFC Tab of the Advanced Parameters Window

¥ Advanced Parameters [_ O] x|

General | TCRIP RFC] 0K |
Host: I saprisry Cancel |
Destination: I Hel |

Gateway Host: I

Gateway Service: I

System Mumber: I 02

Function: I

This tab contains the following fields:

Host defines the R/3 server to which the RFC server connects. This field
has no predefined default value.

Destination logical name that the sideinfo file uses. Note: If a destination is set
here, other fields on this tab are ignored because the sideinfo file
overrides them. If you use sideinfo files to communicate with R/3,
enter the correct symbolic destination. The sideinfo file is discussed
in “Sideinfo File” on page 22.

Gateway Host gateway host that the RFC server uses to communicate with the R/3
system. The default value is Host.

Gateway the communication gateway service that R/3 uses.
Service

System Number the system number that identifies which R/3 system to access if
more than one R/3 system resides on the same host. At times, more
than one R/3 system operates on the same host. For example, a
development or test R/3 system can operate on the same host
hardware as a production R/3 system. In this case, multiple R/3
systems can be accessed separately by using system numbers. The
default value for this field is 0 (zero).

Function the SAS function to call as part of the R/3 logon process. You can
specify the R/3 function module that is used for RFC.

Sideinfo File

The sideinfo file is a text file that you can use to set logon parameters for R/3 users,
including the RFC host, system number, gateway service, and gateway host. Placement
of the sideinfo file is host- and release-dependent. In general, the sideinfo file defaults
to the current directory, but an environment variable can override this. Refer to R/3
system documentation for specific platform and release-level details.
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If you are using a sideinfo file, you need to set only the Destination field on the RFC
tab in the Advanced Parameters window of the Logon to R/3 utility before entering
information for other parameters in the sideinfo file.

Using the Local Setup Utility

Use the local setup utility to display the Application Setup window, which you can
then use to define various application parameters. You can use the local setup utility to
specify the default location from which data is extracted and the default location where
data is stored. The utility also defines several other parameters that determine how the
SAP data is extracted and where the extracted metadata is stored in SAS.

Application Setup Window

Use the Application Setup window to set parameters for logging on and accessing
data using SAS/ACCESS Interface 4.2 to R/3.
Follow these steps to display the Application Setup window:

1 From the SAS desktop, open the SAS/ACCESS to R/3 desktop that is shown in
Display 4.1 on page 17.
2 To open the Application Setup window, double-click the Local Setup icon.

You can also display the Application Setup window from the Datamodel
Explorer. From the pull-down menu, selectTools » Options » ACCESS to R/3

Display 4.9 Application Setup Window

I SAS/ACCESS to R/3: Application Setup Mi=] B3
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Reset |
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SAS Data Library: ISASUSER j
Source Library: ISASUSER j
Type: IVieW j
Replace: IND j

The Application Setup window contains the following buttons:

closes the window, saving any entered parameters.
Cancel closes the window without saving any entered parameters.

resets the parameters on the window to their defaults.

=d
©
(2]
@
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Help displays the SAS Help for the Application Setup window.
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Defaults Tab

The pefaults tab presents default settings to generate the views and save the
source. This tab contains the following items:

Host specifies the target machine where extracted data is saved. Select
either -LOCAL- (the default value) or a remote host, if defined. A
remote host is the session ID of a running SAS/CONNECT session.

Descriptor specifies the location on the selected host where descriptors are

Library saved. Select a library. The default value is SASUSER.

SAS Data specifies the location on the selected host where the SAS view or

Library data file is saved. Select a library. The default value is SASUSER.

Source specifies the location on the selected host in which the source is

Library saved. Select a library. The default value is SASUSER.

Type specifies whether the extracted SAP BW metadata is stored in a
SAS view or a SAS data file. Select either view (the default value)
or Data.

Replace determines whether to overwrite the existing view or data file when

performing a new extraction. Select Yes to overwrite existing views
or data sets. Select No (the default avlue) to leave existing views or
data sets untouched.

Data Dictionary Tab

Use the Data Dictionary tab to enter values that specify where the extract of the
R/3 Data Dictionary is located and how to access it.

Display 4.10 Data Dictionary Tab of the Application Setup Window

l'_‘;ir SASSACCESS to R/3: Application Setup

Defaults  Data Dictionary lMisceIIaneous Ok |

Locate the Data Dictionary Extract Cancel |
_ Reset |
Access Type: ILocaI to the Application j
Remaote Host: I-LOCAL- j LI
SAS Library: I j
Local Copy of the SAS Library: I j
This tab contains the following items:
Access Type specifies the location of the data dictionary that contains the SAP

source data that you want to extract. Select either Local to the
Application (the default value) or Remote to the Application.
If the selected access is Local to the Application, then the
Remote Host and Local Copy of the SAS Library fields are
disabled.
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SAS Library
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Library
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specifies the remote machine that contains the source data that you
want to extract if the data dictionary is remote to the application.
The remote host is the session ID of a running SAS/CONNECT
session. If the data dictionary is local to the application, this field is
disabled.

enables you to select the SAS library that identifies the location of
the data dictionary. If you are using a local host, this is the same
library to which you extract metadata. If you are using a remote
host, then you should specify a SAS library that references the
location of the metadata on the remote host. The default value is
R3LIB.

enables you to select the SAS library that identifies the local copy of
the data dictionary. If the data dictionary extract resides on a
remote host, the (accessed) information can be stored in a local copy
for better performance. If the data dictionary is local to the
application, this field is disabled.

Miscellaneous Tab

Use the Miscellaneous tab to define a limit for the number of observations to
display when showing SAP data in the Datamodel Explorer.

Display 4.11 Miscellaneous Tab of the Application Setup Window

E'EI_ SAS/ACCESS to R/3: Application Setup M=l E3

Defaurts] Data Dictionary  Miscellaneous ] a3 |
- ) Cancel |
Limit of abservations for Show Data: 100

Reset |
Help |

This tab contains the following item:

Limit of
observations

for Show Data

enables you to define the maximum number of observations to
display for a data query. The default value is 100.
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Using the Datamodel Explorer

Use the Datamodel Explorer window to visually explore data models of the R/3
database, similar to a tree diagram of directory files and subdirectories. The Datamodel
Explorer helps you navigate through the R/3 data model and its many subordinate data
models.

The Datamodel Explorer window shows a tree diagram of data models in the R/3
database. The R/3 data model is at the top of the tree, and the subordinate data models
branch from it. End nodes on the tree diagram are entities. Each entity type can
contain one or more tables. By using the Datamodel Explorer, you can find the table
that SAS/ACCESS Interface 4.2 to R/3 is accessing. After you identify a table, you can
perform the following tasks:

O

modify the field selection

set a ABAP WHERE clause on that table

create SAS views for that table

display table information directly in the Datamodel Explorer

O o o od

display additional meta-information about the identified table
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Datamodel Explorer Window

To start the Datamodel Explorer, go to the SAS desktop and open the SAS/ACCESS

to R/3 desktop that is shown in Display 4.1 on page 17.
To open the Datamodel Explorer window, double-click the Datamodel Explorer icon:

Display 4.12 Datamodel Explorer Window

E¥. Datamodel Explorer 0]
=
S,f‘.P_DM SAP Data Model
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[}5aP_aRC Architecture
=
N I

The Datamodel Explorer window opens with the collapsed tree diagram in the left
half of the window. When you select a data model from the tree diagram, the Sub Data
Models tab displays in the right half of the window as shown in Display 4.13 on page 28.

To expand the tree diagram, click the plus sign [+] or double-click the corresponding
data model name. You can also open and close data models by clicking with the right
mouse button on a data model and selecting Expand or Collapse from the pop-up menu.

Sub Data Models Tab

The Sub Data Models tab in the right half of the Datamodel Explorer window shows
the name and a short description for all subdata models in the data model that you
selected in the tree diagram. Selecting a data model in the left half of the Datamodel
Explorer window displays the Sub Data Models tab in the right half of the window.
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Display 4.13 Sub Data Models Tab of the Datamodel Explorer Window
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All Entity Types Tab

The A1l Entity Types tab in the right half of the Datamodel Explorer window
displays a table that describes the entity types within the data model that was selected
in the tree diagram. For each entity type, the table displays its name and a short text
description, as shown here:

Display 4.14 All Entity Types Tab of the Datamodel Explorer Window
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Assigned Tables Tab

To display the Assigned Tables tab, from the A1l Entity Types tab double-click
any line item.

By selecting an entity type and double-clicking it, the Datamodel Explorer searches
for the entity type, expands the tree diagram, and scrolls until the selected entity type
is visible and then highlights that entity type. The right half of the Datamodel Explorer
window changes to show information about that entity type with the Assigned Tables
tab (the default value, shown below) and Attributes tab.

Display 4.15 Assigned Tables Tab of the Datamodel Explorer Window
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The Assigned Tables tab displays the Entity View name and a table that lists one
or more tables that the entity type contains.

Attributes Tabh

To display the Attributes tab, from the A11 Entity Types tab, double-click any
line item and then click the Attributes tab.
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Display 4.16 Attributes Tab of the Datamodel Explorer Window
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An attribute is a field of an entity view. The Attributes tab displays a table that
contains the name and a short description of the fields in the selected table.

Datamodel Explorer Window Menus

The Datamodel Explorer window contains several menus. While Edit, Solutions,
Window, and Help menus are part of the standard SAS environment and are fully
documented in your SAS reference manuals, the File, View, Tools, and Connections
menus have commands that are specific to SAS/ACCESS Interface 4.2 to R/3.

File Menu

Display 4.17 File Menu of the Datamodel Explorer Window
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The R/3 File menu contains the following commands:

Properties displays the General Attributes for a List of Tables window that is
shown in Display 4.22 on page 36.

Export refines the choice to export to either SAS/Warehouse

Metadata Administrator or to SAS Datasets.

Select saAs/Warehouse Administrator to display the Export
Metadata to SAS/Warehouse Administrator window that is shown in
Display 4.34 on page 50. Select SAS Datasets to display the Export
Metadata window that is shown in Display 4.33 on page 49.

View Menu

Display 4.18 View Menu of the Datamodel Explorer Window
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The R/3 View menu contains the following commands:

List of displays the List of R/3 Tables window that is shown in Display 4.31
Tables on page 47.
List of displays the List of R/3 Descriptors window that is shown in Display

Descriptors 4.32 on page 48.
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Tools Menu

Display 4.19 Tools Menu of the Datamodel Explorer Window
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The R/3 Tools menu contains the following commands:

Create Views

Create R/3
Descriptors

Search
Metadata

creates SAS data views to the R/3 tables. If the views already exist,
a dialog box prompts you to decide whether you want to cancel,
overwrite all currently existing views or to decide on an individual
view basis. A data set type of ACCR3 is added to all data sets and
views that SAS/ACCESS Interface 4.2 to R/3 creates.

creates the R/3 descriptors. You should only use SAS/ACCESS
Interface 4.2 to R/3 to delete descriptors that were created using the
interface. Internal tables track the descriptors, and using external
tools to delete descriptors can make the tables inconsistent.

displays the Data Dictionary Search Facility window that is shown
in Display 4.36 on page 52.

Connections Menu

Display 4.20 Connections Menu of the Datamodel Explorer Window

Logon ta BA3...

Lizt Connectionz

Logoff




Using SAS/ACCESS Interface 4.2 to R/3 A List of Connections Window 33

The R/3 Connections menu contains the following commands:

Logon to R/3 displays the Logon to R/3 window that is shown in Display 4.2 on

page 17.
List displays the SAS/ACCESS to R/3: List of Connections window that
Connections is shown in Display 4.21 on page 33.
Logoff disconnects the current logon profile from the R/3 system.

List of Connections Window

Use the List of Connections window to display the current and available user profiles
for connecting to the R/3 systems. You can also use the List of Connections window to
log on to the systems.

Follow these steps to display the List of Connections window:

1 From the SAS/ACCESS to R/3 desktop, start the Datamodel Explorer.
2 From the Datamodel Explorer menu, select Connections » List Connections.

The List of Connections window displays.

Display 4.21 List of Connections Window
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The drop-down list on the upper left side of the window displays the type of
connection that is shown in the connection list box. Click the down arrow icon to view
the Available connections or Open connections connection types. The connection
list box on the lower left side of the window then displays a list of connections for that
connection type.

When you select Available connections, the following buttons are available:

displays the Logon to R/3 window, which allows you to edit the
profiles.

connects to an R/3 database by using the connection parameters that
are selected in the connection list box. If no connection is selected in
the connection list box, this button is disabled.

displays the Logon to R/3 window that is shown in Display 4.2 on
page 17.

Remove deletes the connection that is selected in the connection list box. If

no connection is selected in the connection list box, this button is
disabled.
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saves your changes, closes the List of Connections window, and
returns you to the Datamodel Explorer window.

displays the SAS Help for the List of Connections window.
When you select Open Connections, the following buttons are available:

disconnects the open connection that is selected in the connection
list box. If no connection is open, this button is disabled.

saves your changes, closes the List of Connections window, and
returns you to the Datamodel Explorer window.

displays the SAS Help for the List of Connections window.

When you select a connection in the connection list box, the following tabs display in
the right half of the window. Information that is contained in these tabs is similar to
the information that displays in the Advanced Parameters window.

O General
O RFC
O TCP/IP

O More RFC

You can only view the information that is contained in these tabs; you cannot edit
information from this window.

General Tab
The General tab of the List of Connections window contains the following fields:

Connection Id displays the text label for the connection ID. The label must follow
standard SAS syntax.

Remote displays the remote host if one is specified. To read R/3 tables into
SAS data sets on a remote SAS session, you must establish the
connection to the R/3 session in the remote SAS session.

Profile displays the connection profile name.
Description displays a text description of the connection profile.
RFC Tab
The RFC tab of the List of Connections window contains the following items:
Client displays the three-digit R/3 client identification number.
User displays the R/3 user ID.
Language displays the language that the RFC logon uses.
Host displays the R/3 server to which the RFC server connects. No

default value is set for this field.

Destination is a logical name used by the sideinfo file, if one is defined. If a
destination is set here, the sideinfo file overrides information that
you entered in other fields on the RFC tab.
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TCP/IP Tab

The TcP/IP tab of the List of Connections window contains the following fields:

Host displays the network location of the RFC server. The default is
localhost, and a fully qualified domain name is not required. For
example, if the RFC server is reachable by using the DNS name
rfc.example.com and is on the local area network, the Host field
accepts either rfc or rfc.example.com. It also accepts numeric
addresses.

Port displays the TCP/IP port to use for communicating with the RFC
server. The default port number is 6991.

More RFC Tab

The More RFC tab of the List of Connections window contains the following fields:

Gateway Host displays the gateway host that the RFC server uses to communicate
with the R/3 system. The default value is Host.

Gateway displays the communication gateway service that is used by R/3.

Service

System Number displays the system number that identifies which R/3 system to
access if more than one R/3 system resides on the same host. At
times more than one R/3 system can operate on the same host, such
as a development or test R/3 system that runs on the same host
hardware as a production R/3 system. The default value is 0.

Function specifies a SAS function to call as part of the R/3 logon process.

General Attributes for a List of Tables Window

Use the General Attributes for a List of Tables window to display the descriptor, SAS
data view, and source entry for selected tables of the data model that you selected in
the main window of the Datamodel Explorer.

To display the General Attributes for a List of Tables window that is shown in
Display 4.22 on page 36, start the Datamodel Explorer and select a data model from the
tree diagram and then perform one of the following actions:

o Select File » Properties.

0 Select View » List of Tables to display the List of R/3 Tables window that is
shown in Display 4.31 on page 47, and then select a table and click [Properties].

o0 Right-click the selected data model and select Properties from the pop-up menu.
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Display 4.22 General Attributes for a List of Tables Window
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The window displays all tables that are associated with the data model that is
selected in the main window of the Datamodel Explorer window. The three columns of
the table display the table identifier, the text description of the table, and the table type.

The General Attributes for a List of Tables window contains the following items:

Use Defaults

Auto Replace

R/3 Table

R/3
Descriptor

resets the values for the selected table to the default values.

specifies whether you want to automatically overwrite the existing
descriptor, data file (either a view or a data set), and source library
for the selected table with any changes you have made on the
General Attributes for a List of Tables window. Select the check box
to automatically save changes to the descriptor, data file, and source
library and to overwrite the existing table information when you
click [Save]. Do not select the check box if you want to be prompted
whether to overwrite the existing table information when you click

[Save].

displays the table identifier in the Table column on the General
Attributes for a List of Tables window. You cannot edit this field.

enables you to specify a descriptor for the selected table. Click the
down arrow to display a pull-down list of previously saved
descriptors. Right-click inside the field to display a pop-up menu
that enables you to perform the following actions:

0 Enter a new catalog entry name for the selected descriptor
using the Enter Catalog Entry Name window that is shown in
Display 4.25 on page 40.

0 Save the selected descriptor.
0 Load the selected descriptor.

0 Delete the selected descriptor.
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SAS Data File enables you to perform the following actions:

0 Enter a new data set name for the selected descriptor using the
Enter Dataset Name window that is shown in Display 4.24 on
page 39.

0 Save the specified SAS data file.
0 Delete the specified SAS data file.
Click the ellipsis (...) icon at the right of the field to display the
Enter Dataset Name window. Right-click inside the field to display a
pop-up menu that enables you to save or delete the SAS data files.
Source Entry enables you to perform the following actions:

0 Enter a new catalog entry name using the Enter Catalog Entry
Name window that is shown in Display 4.25 on page 40.

O Save the specified source entry.

0 Delete the specified source entry.
Click the ellipsis (...) icon at the right of the field to display the
Enter Catalog Entry Name window. Right-click inside the field to

display a pop-up menu that enables you to save or delete the source
entry.

This window contains the following buttons:

0 closes the General Attributes for a List of Tables window and
returns you to the Datamodel Explorer window.

—

closes the window without saving any changes that you have made.

displays the SAS Help for the General Attributes for a List of Tables
window.
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displays the Enter Catalog Entry Name window.
deletes the descriptor that is shown in the R/3 Descriptor field.
Save creates and saves a descriptor of the same name as the selected item

in the R/3 Descriptor field. A dialog box displays to indicate that
the R/3 descriptor was created. If the descriptor already exists, a
dialog box prompts you to replace the existing descriptor file or to
cancel the operation.

The General Attributes for a List of Tables window also contains additional R/3
features that are available from the Tools menu.
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Display 4.23 Tools Menu of the General Attributes for a List of Tables Window
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The R/3 Tools menu contains the following commends:

Create Views creates SAS data views to the R/3 tables. If the views already exist,
a dialog box prompts you to decide whehter you want to cancel,
overwrite all currently existing views, or to decide on an individual
view basis. A data set type of ACCR3 is added to all data sets and
views that SAS/ACCESS Interface 4.2 to R/3 creates.

Create R/3 creates the R/3 descriptors that were the base element of SAS/
Descriptors ACCESS Interface 4.2 to R/3 in previous releases.

Save Source saves the generated source code to the specified source entry.
Create displays the Create Extract Programs window that is shown in
Extract Display 4.26 on page 41.

Programs

Options > displays the Application Setup window that is shown in “Application

Access to R/3  Setup Window” on page 23.
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Enter Dataset Name Window

Use the Enter Dataset Name window to select or create a data set and to specify the
host and library associated with the data set. You can also use it to specify whether the
data set is a view or a data file.

Display 4.24 Enter Dataset Name Window
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To display the Enter Dataset Name window, from the General Attributes for a List of
Tables window, select a table and select the down arrow icon to the right of the sas
Data File field.

This window contains the following items:

closes the window, creating the specified data set.

closes the window.

displays a window that you can use to browse for a library.

displays the SAS Help for the window.

Host specifies the host where the data set is stored.

Library specifies the library where the data set is saved.

Name specifies the name of the data set.

Type specifies the information type for the data set. Valid values are View

and Data Set.

Enter Catalog Entry Name Window

Use the Enter Catalog Entry Name window to select or create a SAS catalog entry, to
specify the host and library associated with the entry, and to specify the type of the
catalog entry.
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Display 4.25 Enter Catalog Entry Name Window
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To display the Enter Catalog Entry Name window, from the General Attributes for a
List of Tables window, select a table, and select the down arrow icon to the right of the
Source Entry field.

This window contains the following items:

closes the window, creating the specified catalog entry.

closes the window.

displays a window that is used to browse for a catalog.

displays the SAS Help for the window.

Host specifies the host where the catalog entry is stored.

Library specifies the library whierethe catalog entry is saved.

Catalog specifies the catalog where the catalog entry is saved.

Entry specifies the name for the catalog entry.

Type displays the information type for the catalog entry. The default is
SOURCE.

Create Extract Programs Window

Use the Create Extract Programs window to help you to generate SAS and R/3
programs for extracting data with an intermediate external file. To display the Create
Extract Programs window, from the General Attributes for a List of Tables window,
select an R/3 table, select Tools, and then select Create Extract Programs.
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Display 4.26 Create Extract Programs Window
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The Create Extract Programs window contains the following items:

generates the source and saves it into the specified catalog entries.
closes the window.

displays the SAS Help for the Create Extract Programs window.

The two display areas are for defining parameters for creating SAS DATA steps and

ABAP source files.

Create SAS
Data Step

SAS Data File

Fileref

Save Source
into

Create ABAP
Source

ABAP Report
Name

ABAP creates
(Filename)

The following items are available for creating DATA steps:

enables the fields for creating a DATA step. If this check box is not
selected, the associated fields are disabled.

specifies the name of the resulting SAS data set or SAS data set
view. Click the icon to the right of the field to open the Enter
Dataset Name window that is shown in Display 4.24 on page 39.

specifies the SAS file reference to the intermediate external file. It
can also be a PIPE to read directly in the output of an ABAP
program. Click the down arrow icon to the right of the field to
display a drop-down list of available filerefs.

specifies the four-level name of a SAS catalog in which to save the
source code of the SAS DATA step. Click the icon to the right of the
field to display the Enter Catalog Entry Name window that is shown
in Display 4.25 on page 40.

displays the SAS data file that is generated from the selections.

enables the fields for creating an ABAP source. If this check box is
not selected, the associated fields are disabled.

specifies the name of the ABAP report that is being generated. The
filename should begin with the letter Z.

specifies an external filename. Click the icon to the right of the field
to display the Save As window.
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Save Source
into

Display 4.27 Save As - SAS/ACCESS to R/3: Create Extract Programs Window
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specifies the four-level name of a SAS catalog in which to save the
source code of the ABAP report. Click the icon to the right of the
field to display the Enter Catalog Entry Name window that is shown
in Display 4.25 on page 40.

displays the generated ABAP program.

Attributes for a Table (Edit) Window

The Attributes for a Table (Edit) window provides information about the
characteristics of specific tables within the R/3 database. To display the Attributes for a
Table (Edit) window, from the General Attributes for a List of Tables window, select an
R/3 table. Click to display the Attributes for a Table (Edit) window.
The Attributes for a Table (Edit) window contains the General Attributes, Fields,
Where, and Related Tables tabs.



Using SAS/ACCESS Interface 4.2 to R/3 A Atiributes for a Table (Edit) Window

Display 4.28 Attributes for a Table (Edit) Window
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This window contain the following buttons:
closes the Attributes for a Table (Edit) window and returns you to
the General Attributes for a List of Tables window, saving your
changes.
closes the Attributes for a Table (Edit) window and returns you to

the General Attributes for a List of Tables window without saving

any change that you might have made.

displays the SAS Help for the Attributes for a Table (Edit) window.

General Attributes Tab

The General Attributes tab of the Attributes for a Table (Edit) window describes

the source for the data and the SAS view.
This tab contains the following items:

R/3 Table specifies the R/3 table from which to read the data.
R/3 enables you to specify a descriptor for the selected table. Click the
Descriptor down arrow to display a pull-down list of previously saved

descriptors. Right-click inside the field to display a pop-up menu

that enables you to

O enter a new catalog entry name for the selected descriptor

43

using the Enter Catalog Entry Name window that is shown in

Display 4.25 on page 40.
o save the selected descriptor.
O load the selected descriptor.
O delete the selected descriptor.

SAS Data File specifies the SAS data view to use with the table. Click the icon to

the right of the field to display the Enter Dataset Name window that

is shown in Display 4.24 on page 39.
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Source Entry specifies the source to which the DATA step is saved. Click the icon
to the right of the field to display the Enter Catalog Entry Name
window that is shown in Display 4.25 on page 40.

resets the drop-down lists to their default settings.
shows the data from the R/3 table.
Fields Tab

The Fields tab is the default tab that is selected when the Attributes for a Table
(Edit) window display. This tab displays the field names and descriptions for the
selected table.

The table on this tab displays the information for each field in the selected table. For
each field in the table, the table and the lower part of the tab display these items:

O Field Name
Primary Key
Description
SAS Name
Format

O 0O oo g

Informat

You can edit the SAS name, the format, and the informat in the lower part of the tab.
During the import process, special characters in the Field Name such as a forward
slash (/) are converted to an underscore (_) in the SAS Name. Also, if a numeric field
has more than 10 decimal places, the decimal places are omitted from the informat and
the affected field is multiplied by 10%* (-d) in the data set.

This tab contains the following buttons:

displays the Select Fields for a table window shown in Display 4.29
on page 45, which allows you to choose which fields of the table
display or are hidden in this tab.

Apply saves changes made to the SAS name, the format, and the informat
in the lower part of the tab.

Long Desc. displays the Long Description window, which displays the long
description for the selected field.

Where Tab

The Where tab enables you to edit or build a clause to query the rows that are
extracted from the R/3 table. You can use SAS/ACCESS Interface 4.2 to R/3 to generate
an ABAP WHERE clause that the application passes to the R/3 system, along with
other parameters such as table name, record length, and so on.

This tab contains the following buttons:

checks the syntax of the entered WHERE clause.

discards any changes made to the WHERE clause.

removes the WHERE statement from the entry field.

displays the ABAP Where Expression Builder window that is shown

in Display 4.30 on page 46.

Related Tables Tab

The Related Tables tab of the Attributes for a Table (Edit) window presents a
cross-reference of R/3 tables (if any) that share a field with the selected table.



Using SAS/ACCESS Interface 4.2 to R/3 A Atiributes for a Table (Edit) Window 45

The Related Tables tab contains two tables. The table on the left half of the tab
displays the abbreviation and description for all R/3 system tables that share a field
with the selected table. Select a table name in the left-hand table to display a second
table on the right half of the tab that displays the field or fields that the two tables
have in common. Double-click a table to display the General Attributes for a List of
Tables window and the properties for the selected table.

Select Fields for a Table Window

To display the Select Fields for a Table window, display the Attributes for a Table
(Edit) window, select the Fields tab, and then click [Select Fields]|. Use the Select Fields
for a Table window to select fields for viewing and querying.

Display 4.29 Select Fields for a Table Window

E¥ SAS/ACCESS to R/3: Select Fields for Table ADDD M =] B3

=howy Field Mame j ISort by Ascending Position j Ok |
Cancel |

Fields Selected Fields Help
MSMDT
HAPPL
KECHL
WAKEY
DaTHEI

LaTap
FMUKH

2 AF[Y

The buttons available on the Select Fields for a Table window are

closes the Select Fields for a Table window and returns you to the
Attributes for a Table (Edit) window, saving your changes.

closes the Select Fields for a Table window and returns you to the
Attributes for a Table (Edit) window without saving any changes.

displays the SAS Help for the window.

Use the drop-down list on the left-hand side of the window to select either Show
Field Name or Show Field Description. Use the drop-down list on the right-hand
side of the window to specify how the fields are sorted in the Fields and Selected
Fields lists. The Selected Fields list shows the fields that are listed in the General
Attributes for a List of Tables window. The Fields list shows the fields that are not
listed in the General Attributes for a List of Tables window.

Use the buttons between the Fields and Selected Fields lists to move fields
between the two list boxes. To move a field from one list box to the other, select the field
name, and then click the left arrow or the right arrow button. To move all of the fields
in a list box to the other list box, click the left double arrow button or the right double
arrow button.
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ABAP Where Expression Builder Window

The ABAP Where Expression Builder window enables you to create queries in ABAP
syntax. To display the ABAP Where Expression Builder window, from the General
Attributes for a List of Tables window, select an R/3 table. Then, click [More Properties]
to display the Attributes for a Table (Edit) window, as shown in Display 4.28 on page
43, and select the where tab. From the where tab, click to display the ABAP
Where Expression Builder window.

Display 4.30 ABAP Where Expression Builder Window
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This window contains the following items:

Display Text

controls whether the label name or description displays in the text
entry field. If you select the check box, the description displays. You
cannot edit the text description.

R/3 Table displays the available variables for the selected R/3 table. Use these
Variables variables to write the WHERE statement.

list box

Logical displays the logical operators for the WHERE statement: equal, less
Operator list than, greater than, null, and so on.

box

And/Or controls the relation of a query clause to the following query clause.

Clear
Rese

Check Syntax

@]
e
2 R

—+ OCD

N

Help

The default value is And.

closes the window and saves the query.

closes the window without saving any changes.

deletes the last change made in the window.

clears the current WHERE query.

resets the query parameters to their previously saved status.
checks the syntax of the query as currently constructed.

displays the SAS Help for the ABAP Where Expression Builder
window.
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a7

controls the insertion of the Where clause. Select on of the valid
actions from the pop-up window: Insert before current line,
Insert after current line, Replace current line, Insert at

the top, and Append at the bottom.

Using the List of R/3

Tables

Use the List of R/3 Tables window to view all R/3 system tables and information
about those tables. To display the List of R/3 Tables, go to the SAS Desktop and open
the SAS/ACCESS to R/3 desktop that is shown in Display 4.1 on page 17. Double-click
the List of R/3 Tables icon to open the List of R/3 Tables window that is shown in

Display 4.31 on

page 47.

To display the List of R/3 Tables window from the Datamodel Explorer, start the
Datamodel Explorer and select View » List of Tables.

List of R/3 Tables Window
The List of R/3 Tables window displays a table that lists all available R/3 system

tables.

Display 4.31
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The table shows the name, type, and a short text description for every table in R/3.
Use the Table Name field to enter a SAS text label for the name of the table. To display
further details for a table, you can use the General Attributes for a List of Tables
window by either double-clicking a table line item or by selecting a table line item from

the list and then clicking [Properties].
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Using the List of Descriptors

Use the List of R/3 Descriptors window to view all R/3 descriptors and information
about those descriptors. To display the List of R/3 Descriptors, go to the SAS Desktop
and open the SAS/ACCESS to R/3 desktop that is shown in Display 4.1 on page 17.
Double-click the List of R/3 Descriptors icon to open the List of R/3 Descriptors window
that is shown in Display 4.32 on page 48.

To display the List of R/3 Descriptors window from the Datamodel Explorer, start the
Datamodel Explorer and select View » List of Descriptors.

List of R/3 Descriptors Window

The List of R/3 Descriptors window displays all descriptors that are associated with a
data model that you selected using the Datamodel Explorer window. In addition to
displaying the descriptors, the List of R/3 Descriptors window shows the tables that are
related to each descriptor and the date when the descriptor was last updated.

Display 4.32 List of R/3 Descriptors Window
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Selecting a line item in the table and clicking Properties displays the General
Attributes for a List of Tables window that is shown in Display 4.31 on page 47.

Export Metadata Window

Use the Export Metadata window to define parameters for exporting metadata from
R/3 tables to a SAS library.
Follow these steps to display the Export Metadata window:

1 Start the Datamodel Explorer.
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2 Select a data model and entity type.
3 Select File » Export Metadata » SAS Datasets from the pull-down menu.
The Export Metadata window displays.

Display 4.33 Export Metadata Window
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From the Destination Libname to Export drop-down list, select the library where
you want to export metadata. A data set type of ACCR3 is added to all data sets and
views that SAS/ACCESS Interface 4.2 to R/3 creates. Then select the type of metadata

to export and whether to replace existing data sets or create new data sets for the
metadata that you are exporting.

Export Metadata to SAS/Warehouse Administrator Window

Use the Export Metadata to SAS/Warehouse Administrator window to define

parameters for exporting metadata from R/3 tables to a SAS data warehouse
environment.

Follow these steps to display the Export Metadata to SAS/Warehouse Administrator
window:

1 Start the Datamodel Explorer.
2 Select a data model and entity type.

3 Select File » Export Metadata » SAS/Warehouse Administrator from the
pull-down menu.

The Export Metadata to SAS/Warehouse Administrator window displays.
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Display 4.34 Export Metadata to SAS/Warehouse Administrator Window
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From the pata Warehouse Environment drop-down list, select the environment to
which you want to export metadata. To define or view properties for the selected
environment, click the ellipses (..) button to display the Data Warehouse Environment
Properties window, as shown in Display 4.35 on page 51. From the Operational Data
Group drop-down list, select the ODD group name, and select or specify the ODD in the
obpD Name field. Then select the type of metadata to export and whether to replace
existing ODDs or create new ODDs for the metadata that you are exporting.

The following information is exported from SAS/ACCESS Interface 4.2 to R/3 to
create SAS/Warehouse Administrator operational data definitions (ODDs). An ODD is
created from each Entity View and Assigned Table. Any new ODD group that SAS/
ACCESS Interface 4.2 to R/3 created in a SAS data warehouse has the Access to R/3
extended attribute.

Tahle 4.1 0DD to Warehouse Administrator Correspondences

ODD SAS/Warehouse Administrator
ODD Name Table/Entity Name

ODD Description Table/Entity Description

ODD Notes Table/Entity Long Description
ODD Data Location SAS Library

ODD Data Location Table/View Name

Fields are exported to columns in an ODD, which should include the name, short
description, format, and informat. If a field has a defined long description, it is exported
as a column note. Finally, the CREATED BY, CVALUE, and
DATAMODEL_OR_ENTITY_TYPE extended attributes are created for each ODD.

Long descriptions cannot be exported by themselves. They can be exported only with
table or table column metadata.

Selecting the ellipses (...) button at the right of the bata Warehouse Environment
field displays the Data Warehouse Environment Properties window, which you can use
to specify or view detailed information about the data warehouse environment.
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Display 4.35 Data Warehouse Environment Properties Window
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This window contains the following items:

Path
Engine

Options
Name
Description

specifies the physical pathname of the directory for the data
warehouses in the environment.

specifies the engine that you want to use to access the environment.
The default engine is v8.

specifies any LIBNAME statement options for the environment.
displays the name of the selected data warehouse environment.
displays a description of the environment, if present.

closes the window, saving any entered properties.

closes the window without saving any entered properties.

displays the SAS Help for the Data Warehouse Environment
Properties window.

Using the

Search Metadata Utility

Use the Search Metadata utility to search the entire R/3 database for a given text
string. You can optionally limit the search to tables, entities, data models, and other
filtering choices.

Data Dictionary Search Facility Window

Use the Data Dictionary Search Facility window to search the R/3 database by using
SAS/ACCESS Interface 4.2 to R/3.
Follow these steps to display the Data Dictionary Search Facility window:
1 From the SAS desktop, open the SAS/ACCESS to R/3 desktop that is shown in
Display 4.1 on page 17.

2 Double-click the Search Metadata icon to open the Data Dictionary Search Facility

window.
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Display 4.36 Data Dictionary Search Facility Window
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Note: You can also display the Data Dictionary Search Facility window from the
Datamodel Explorer by selecting Tools » Search Metadata from the pull-down menu. A

This window contains the following items:

searches for the entered string and uses the current options.

Reset All clears the search string from the entry field and resets the
parameters on the options tab to their defaults.

closes the Data Dictionary Search Facility window and returns you
to the Datamodel Explorer window.

displays the SAS Help for the Data Dictionary Search Facility
window.

Select displays the Datamodel Explorer and expands the tree diagram to

show a selected data model or entity type that was found by the
query. If a table in the results table is selected when you click
[Select], the General Attributes for the List of Tables window displays.

Search String Tah

The search String tab enables you to query the data dictionary using a text search
string. Use the Search String tab when you are searching the data dictionary for one
or more specific data models.

Text field specifies a text string with which to search the R/3 system.
Searching with a special character such as a forward slash (/)
requires single quotation marks around the special character. For
example, enter and’/’or to search for the and/or string.

clears the text field.

Options Tab

Use the options tab to set parameters for a query against the data dictionary. You
can specify the elements and fields that you want to include in the search, as well as
the number of matches you want to display in the list of results.
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Display 4.37 Options Tab of the Data Dictionary Search Facility Window
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This tab contains the following items:

Datamodels searches the data model element for the search string. This check
box is selected by default.

Entity Types searches the entity element for the search string. This check box is
selected by default.

Tables searches the table element for the search string. This check box is
selected by default if the window displayed from the Search
Metadata icon on the desktop. However, if you displayed this
window from the Datamodel Explorer, the check box is not
automatically selected.

Columns searches the column element for the search string. By default, this
check box is not selected.

Set Max. enables you to customize the number of matches to display from the

Number query. If you select this option, enter the maximum number of

matches in the entry field to the right of the radio button. The
default is 100 matches.

Unlimited displays all matches for the query.

Name searches the name field for the search string. This check box is
selected by default.

Description searches the description field for the search string. This check box is
selected by default.

Case requires that the case match the query specifications.

Sensitive

Performing Batch Operations

You can use batch operations to automate processes; for example, you can use them
for overnight operations or to simplify connections for end users.
To open the connection for a batch operation, use the following code:

$r3connb(profile=profile-name, libref=SAS-libref, function=OPEN);
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profile-name specifies the name of the profile that is used to save the info in the
Logon to R/3 window.

SAS-libref specifies the SAS library where the profile was saved. If this
parameter is not specified, the profile will be looked for in the SAS
libraries WORK, SASUSER, and R3LIB (in that order).

function=OPEN opens the connection.
To close the connection, use the following code:
$r3connb(profile=profile-name, libref=SAS-libref, function=CLOSE);
or
$r3connb(id=connection-id, function=CLOSE);

profile-name specifies the name of the profile that is used to save the info in the
Logon to R/3 window.

SAS-libref specifies the SAS library where the profile was saved. If this
parameter is not specified, the profile is searched for in the SAS
libraries WORK, SASUSER, and R3LIB (in that order).

function=CLOSE disconnects from the R/3 system.

connection_id  specifies the connection ID.

Source Parameter

Previous versions of SAS/ACCESS Interface 4.2 to R/3 included the use of a source
parameter in the batch connection. For backward compatibility, use of the source
parameter as described below is still supported, although not recommended.

Submit the following macro in SAS to set up the connection for batch:

$r3connb (source = libref.catalog.entry.SOURCE );

If operating in batch mode, disconnect before exiting by issuing the following
command in SAS:

$r3connb (source = libref.catalog.entry.SOURCE, function = close);

Passwords

In batch processing, all parameters to log on to an R/3 system are generally stored in
permanent SAS catalog entries. If you do not want to store all parameters, particularly
the user ID, password, and client, you can use the following SAS code to prompt the
user for this information. In this scenario, all other connection information—the
function module name, the gateway host, or the gateway service—have to be entered in
the Application Setup window when you create the SAS DATA step view.

/K e * /
/* This SAS program demonstrates how to prompt a user */
/* for the R/3 user ID, password, client, and */
/* language information. */
/* The remote processing is enclosed in comments. */
/K e e * /
*--—- reset password ---*;

$let pwd=;
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*——- set the message text ---%*;

%let message=Please enter the R/3 logon parameter;

*——— prompt the user for the parameters ---%*;

¥macro secure;

%global usr pwd cli 1lng;

$window R3 columns=80 rows=15
#2 @5 message 50 protect=yes
#4 @5 "User : " usr 10 required=yes
#6 @5 "Password: " pwd 10 display=no required=yes
#8 @5 "Client : " cli 3 required=yes
#10 @5 "Language : " 1lng 1 required=yes;

%display R3;

¢mend secure;

%secure;
/* === for remote processing */
*——— macro to pass macro variables to ---%;
*-—— a remote SAS session ---%;

$macro syslput(macvar,macval,remote=);

%let str=%str(rsubmit &remote ;);

gnrstr(%let) %str(&macvar = &macval ; endrsubmit;);
&str ;

gmend syslput;

*——— pass macro variables to the remote SAS session ---%*;
$syslput(usr, &usr);
$syslput (pwd, &pwd) ;
$syslput(cli,&cli);
$syslput(lng, &lng);

*——— submit the code to the remote SAS session ---%*;
rsubmit;

=== end of remote processing */

*——— a temporary catalog entry for the connection ---*;

*——— parameters ---%*;

%let source=work.r3conn.connl.source;

*-—— the connection id ---*;
*——— ATTENTION: This has to be the same connection ID ---%*;
*——- as the one that was used to create the views. ———%

%let cconn=connl;

*——— the host/port where the RFC server program --—-%;
*——— is running ---*;

%let tcphost=cafe7.eur.sas.com;

$let port=6991;

*——— set the R/3 host parameter ---%*;

55
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%let hst=hostname;

*--—- save the parameters to the temporary catalog ---*;
*——= entry ---%*;
proc display c=sapr3.sr3dbi.savconnb.scl;

run;

*——— connect to the R/3 system —---*;
$r3connb(source=&source) ;

*-—- use the Data Step view you have created with the ---%*;
*—-—— SAS/ACCESS Interface 4.2 to R/3 —---%*;
*-—- close the connection to the R/3 system ---*;

$r3connb(source=&source, function=close);

/* === for remote processing

endrsubmit;

=== end of remote processing

*/

*——- end of sample program ---*;
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Overview of the RFC Server

The RFC server is part of SAS/ACCESS Interface 4.2 to R/3 as described in Chapter
3, “Accessing and Using R/3 Data,” on page 11. The RFC server is a component of the
SAP LIBNAME engine that provides access to the data in SAP R/3 and SAP BW
systems. The RFC server also supports calling ABAP RFC functions. The RFC server
uses the TCP/IP protocol for communication with the SAP LIBNAME engine. For more
information about the SAP LIBNAME engine, see “Overview of the LIBNAME Engine
for SAP” on page 79.

The RFC server has the following features:

0 It runs independently of SAS as a background process on the SAS host, the R/3
host, and another machine entirely.

0 It can be configured to listen on any TCP/IP port (default 6999).

0 It can have more than one concurrent instance on a given machine (but each

instance must have a unique port number). Each instance can communicate with
many SAP R/3 or SAP BW system servers.

0 It can process requests from multiple SAP application servers.

O It can support Unicode and non-Unicode SAP R/3 servers. The Unicode RFC
server can be started from Windows only, but it can support Unicode SAP R/3 and
SAS on all platforms. See “Using the RFC Server on Windows NT” on page 62 for
information on starting a Unicode RFC server.
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ABAP Function Modules and Programs

Some of the ABAP function modules and programs that were available in
SAS/ACCESS Interface to R/3, Release 8.2, are no longer used in version 9 and later of
SAS/ACCESS Interface 4.2 to R/3. These function modules and programs were used by
the RFC server and the dialog RFC server that were included in the software prior to
these releases. The new RFC server and RFC dialog server no longer use the following
ABAP function modules and programs:

O Z_SAS_BATCH_INTERFACE_4
O Z_SAS_READ _TABLE CPIC

O ZSASRDTB

O ZSASRDBT

Version 9 and later of SAS/ACCESS Interface 4.2 to R/3 also include SAP transport
files that you can use to install the ABAP function modules and programs. It is
recommended that you import the SAP transport files rather than installing the ABAP
function modules and programs manually. For more information about installing ABAP
function modules and programs using version 9 and later of SAS/ACCESS Interface 4.2
to R/3, refer to the Installation Instructions for SAS/ACCESS Interface to R/3.

Note: The transport files for SAS/ACCESS Interface 4.2 for R/3 contain different
ABAP function modules and programs than the transport files for SAS/ACCESS
Interface 4.2 to SAP BW. Make sure you use the correct files when installing your
application. A

Using the RFC Server on UNIX

In a UNIX environment, the SAS RFC server for SAP is installed in the !sASRoOT/
saspgm/dbi/bin directory. You must add this directory to the PATH environment
variable and add the location of the shared libraries to the appropriate environment
variable. For more detailed information about how to set up the environment variables,
see Installation Instructions for SAS/ACCESS Interface to R/3.

To start the SAS RFC server in a UNIX environment, use the following command

sasrfc_server [-d 0|1|2|3|4|5|6] [-n name] [-p port] [-w workdir] [-N namespace]
[-V variant] [-help] [-c dialog_compat_port]
[-b "-p port_number -V variant_name -R report_name"]

[-B number of bytes] [-S "-a program_id -g gateway_host -x gateway service"]

where optional parameters are enclosed in brackets [ ].

To stop the RFC server in a UNIX environment, use the following command
sasrfc_server [-k] [-p port]

where optional parameters are enclosed in brackets [ ].

The SAS RFC server command for UNIX has the following options:

-dn
specifies whether to run the server as a daemon process or as an application and
specifies the diagnostic level.
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The server is run as a daemon process when you specify -dn where n=0 or when
you do not specify the -dn option. After successful initialization, all messages are
routed to syslog.

When you specify the -dn option where n= any number between 1 and 6, the
program runs as an application and messages are routed to standard error. Higher
diagnostic levels route more detailed messages to standard error.

-k
stops the service.

-n name
specifies the name of the service. This option is used to distinguish multiple
daemon processes. For example, a test service might be started as -n test.

-p port
identifies the port number on which the service listens. The default port number is

6999.

-w workdir
specifies the working directory. For example, if your working directory is named
tmp, specify the option as follows: -w /tmp.

-N namespace
specifies the namespace for ABAP functions and programs that are used by SAS.
The default value is /sas/. If the ABAP programs are installed in the customer
namespace rather than in the /SAs/ namespace, then this parameter identifies
where the ABAP programs are installed.

-V variant
specifies the R/3 report variant that is assigned to this server. You must assign a
report variant for each RFC server that accesses an R/3 application server in batch
mode. The variant parameter G_DEST specifies a unique destination to call back
to the RFC server.

-help
specifies that you want to display command line Help.

-¢ dialog_compat_port
identifies the option that, when specified, runs the RFC server in V8 compatibility
mode on the port indicated by the dialog_compat_port parameter. The port
number must be different than the one used for the V9 requests. If the -c option is
omitted, no dialog compatibility will be available.

-b “-p port_number -V variant_name —R report_name”

enables batch compatibility so that you can process V8 ACCR3 requests while you
are using a V9 RFC server. You must use the double quotation marks in the batch
compatibility option in order to separate the batch compatibility parameters from
the V9 parameters that use the same syntax.

The port parameter is optional. If omitted, the port number defaults to 6995.

The report variant parameter is required and must be a valid variant of the
report.

The report parameter is optional and normally is omitted. If the report
parameter is omitted, then repori_name defaults to /SAS/ZSASVE8COMPAT.

The values in port_number, variant_name, and report_name must be different
from the values used by V9 and different from the values used by dialog
compatibility.

-B number_of _bytes
sets the minimum buffer size for data transfers in batch and dialog modes. The
number of bytes should be greater than 10000 and no more than eight digits, or it
will be ignored. If the —B option is omitted, the default is 10000 bytes.
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If you specify a value for the G_BUFMAX parameter that is less than the value
of —B in batch mode, then the —B value is used.

The options for the SAS RFC server command and the options for the Unicode RFC
server on Windows NT are as follows:
—-in
installs the program as a Windows service and specifies the startup option for a
new service. Startup options are

n=2 starts the service automatically
n=3 starts the service on demand
n=4 disables the service.

-

removes the program from the Service Manager.
-8

starts the service.
-k

stops the service.

—tn
sets the startup option for an existing service. Startup options are

n=2 starts the service automatically
n=3 starts the service on demand
n=4 disables the service.

-dn

specifies the diagnostic level. When you specify the -d n option where n= any
number between 1 and 6, the program runs as an application and messages are
routed to standard error. Higher diagnostic levels route more detailed messages to
standard error.

—n name,desc
specifies the name and description of the service.

—p port
specifies the port number on which the server listens. The default port number is
6999.

-N namespace
specifies the namespace for ABAP functions and programs that are used by SAS.
The default value is /sas/. If the ABAP programs are installed in the customer
namespace rather than in the /SAs/ namespace, then this parameter identifies
where the ABAP programs are installed.

-V variant
specifies the R/3 report variant that is assigned to this server. You must assign a
report variant for each RFC server that accesses an R/3 application server in batch
mode. The variant parameter G_DEST specifies a unique destination to call back
to the RFC server.

—help
specifies that you want to display command line Help.

-¢ dialog_compat_port
identifies the option that, when specified, runs the RFC server in V8 compatibility
mode on the port indicated by the dialog_compat_port parameter. The port
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number for a 9.1 request must be different than the one used for the version 9
requests. If the -c option is omitted, no dialog compatibility will be available.

-b “-p port_number -V variant_name —R report_name”

enables batch compatibility so that you can process V8 ACCR3 requests while you
are using a V9 RFC server. You must use the double quotation marks in the batch
compatibility option in order to separate the batch compatibility parameters from
the V9 parameters that use the same syntax.

The port parameter is optional. If omitted, the port number defaults to 6995.

The report variant parameter is required and must be a valid variant of the
report.

The report parameter is optional and normally is omitted. If the report
parameter is omitted, then repori_name defaults to /SAS/ZSASVS8COMPAT.

The values in port_number, variant_name, and report_name must be different
from the values used by V9 and different from the values used by dialog
compatibility.

-B number_of _bytes
sets the minimum buffer size for data transfers in batch and dialog modes. The
number of bytes should be greater than 10000 and no more than eight digits, or it
will be ignored. If the —B option is omitted, the default is 10000 bytes.
If you specify a value for the G_BUFMAX parameter that is less than the value
of —B in batch mode, then the —B value is used.

-S "-a program_id -g gateway_host -x gateway_service"
permanently registers the SAS RFC server at an SAP gateway. You must specify
the -S option in order to use the SAS RFC Monitor in the SAP Netweaver Portal.
The option enables the server to receive requests for information from the RFC
Server Monitor through a remote function call that uses an SM59 destination.
To register the server at more than one gateway, specify the —S option multiple
times.

-a program_id
the program_id that you specify must match the program ID that you assign
in the SM59 destination of type registration. The destination that you use
must not be the same as other destinations that are used for batch
extractions.

-g gateway_host
A valid SAP gateway host.

-X gateway_service
A valid SAP service.
For information about other setup requirements for using the SAS RFC Server
Monitor, see the SAS RFC Server Monitor help in the SAP Netweaver Portal.

For example, to start the SAS RFC server as a daemon process with the name of
test on port number 6991, use the following command:

sasrfc_server -n test -p 6991
The following example command shows how to display command line Help:
sasrfc_server

To start the SAS RFC server with debug level 4 on port number 6991, use the
following command:

sasrfc_server -d 4 -p 6991
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To stop a SAS RFC server that is running on port number 6991, use the following
command:

sasrfc_server -k -p 6991

Using the RFC Server on Windows NT

In a Windows NT environment, the SAS RFC server and the Unicode RFC server for
SAP are installed in the ! SASROOT\access\sasexe directory.

To start or stop the SAS RFC server using a command line in the Windows NT
environment, use the following command:

sasrfc_server [-i n] [-r] [-s] [-k] [-t n] [-d n] [-n name[,desc]] [-p port]
[-N namespace] [-V variant] [-help] [-c dialog_compat_port]
[-b "-p port-number -V variant_name -R report_name"]
[-B number of bytes] [-S "-a program id -g gateway host -x gateway service"]

To start or stop the Unicode RFC server using a command line in the Windows NT
environment, use the following command. Note that the Unicode RFC server is used to
access Unicode SAP systems, and it cannot be used to access non-Unicode SAP systems.

sasrfc_serveru [-i n] [-r] [-s] [-k] [-t n] [-d n] [-n name[,desc]] [-p port]
[-N namespace] [-V variant] [-help] [-c dialog_compat_port]
[-b "-p port_number -V variant_name -R report_name"]
[-B number of bytes] [-S "-a program_id -g gateway_host -x gateway service"]

The options for the SAS RFC server command and the options for the Unicode RFC
server on Windows NT are as follows:
-in
installs the program as a Windows service and specifies the startup option for a
new service. Startup options are

n=2 starts the service automatically
n=3 starts the service on demand
n=4 disables the service.

-
removes the program from the Service Manager.
—s
starts the service.
-k
stops the service.

—tn
sets the startup option for an existing service. Startup options are

n=2 starts the service automatically
n=3 starts the service on demand
n=4 disables the service.

-dn

specifies the diagnostic level. When you specify the -d n option where n= any
number between 1 and 6, the program runs as an application and messages are
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routed to standard error. Higher diagnostic levels route more detailed messages to
standard error.

—n name,desc
specifies the name and description of the service.

—p port
specifies the port number on which the server listens. The default port number is

6999.

-N namespace
specifies the namespace for ABAP functions and programs that are used by SAS.
The default value is /sas/. If the ABAP programs are installed in the customer
namespace rather than in the /SAs/ namespace, then this parameter identifies
where the ABAP programs are installed.

-V variant
specifies the R/3 report variant that is assigned to this server. You must assign a
report variant for each RFC server that accesses an R/3 application server in batch
mode. The variant parameter G_DEST specifies a unique destination to call back
to the RFC server.

—help
specifies that you want to display command line Help.

-¢ dialog_compat_port
identifies the option that, when specified, runs the RFC server in V8 compatibility
mode on the port indicated by the dialog_compat_port parameter. The port
number for a 9.1 request must be different than the one used for the version 9
requests. If the -c option is omitted, no dialog compatibility will be available.

-b “-p port_number -V variant_name —R report_name”

enables batch compatibility so that you can process V8 ACCR3 requests while you
are using a V9 RFC server. You must use the double quotation marks in the batch
compatibility option in order to separate the batch compatibility parameters from
the V9 parameters that use the same syntax.

The port parameter is optional. If omitted, the port number defaults to 6995.

The report variant parameter is required and must be a valid variant of the
report.

The report parameter is optional and normally is omitted. If the report
parameter is omitted, then repori_name defaults to /SAS/ZSASVS8COMPAT.

The values in port_number, variant_name, and report_name must be different
from the values used by V9 and different from the values used by dialog
compatibility.

-B number_of _bytes
sets the minimum buffer size for data transfers in batch and dialog modes. The
number of bytes should be greater than 10000 and no more than eight digits, or it
will be ignored. If the —B option is omitted, the default is 10000 bytes.
If you specify a value for the G_BUFMAX parameter that is less than the value
of —B in batch mode, then the —B value is used.

-S "-a program_id -g gateway_host -x gateway_service"
permanently registers the SAS RFC server at an SAP gateway. You must specify
the -S option in order to use the SAS RFC Monitor in the SAP Netweaver Portal.
The option enables the server to receive requests for information from the RFC
Server Monitor through a remote function call that uses an SM59 destination.
To register the server at more than one gateway, specify the —S option multiple
times.
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-a program_id
the program_id that you specify must match the program ID that you assign
in the SM59 destination of type registration. The destination that you use
must not be the same as other destinations that are used for batch
extractions.

-g gateway_host
A valid SAP gateway host.

-x gateway_service
A valid SAP service.
For information about other setup requirements for using the SAS RFC Server
Monitor, see the SAS RFC Server Monitor help in the SAP Netweaver Portal.

For example, if you want to start the RFC server with a debug level of 1 on port
number 6991, use the command below. Note that the following examples also work
using Unicode server command sasrfc_serveru.

sasrfc_server -d 1 -p 6991

To install the RFC server as a service with automatic startup on port 6991 and use
the name test and a description of 'Test RFC server’, use the following command:

sasrfc_server -i 2 -n ‘‘test,Test RFC server’’ -p 6991

To uninstall the server that was started in the previous example, use the following
command:

sasrfc server -r -n ‘‘test’’

Using the RFC Server in Batch Mode

The RFC server can perform batch mode processing of RFC calls to the SAP system.
Users who submit interactive RFC calls to the SAP system might encounter time-out
limitations. This occurs when interactive SAP jobs exceed the default processing
time-out limit of 10 minutes.

By allowing batch mode processing of RFC calls to the SAP system, time-out
limitations for interactive SAP dialog processes are resolved. Batch mode processing is
often employed to reduce the use of dialog processes and to reduce the impact of
extractions (a SAS program reading the tables and views of the SAP system by means
of the LIBNAME engine) on the SAP system. Batch processes usually run at a lower
priority. Batch mode processes of RFC calls can also help control the number of
simultaneous extractions.

The ABAP program that is normally generated (by another ABAP program), executes
a requested read and join operation on the database table(s). When operating in batch
mode, the RFC server creates and releases an SAP job to execute this ABAP program.
The RFC server then waits for the job that is running the ABAP program to start and
to recall the RFC server. Finally, the resulting data stream (that the RFC server
receives from the SAP system) is passed on to the LIBNAME engine.

LIBNAME or data set option: BATCH | BATCH_MODE | BATCHMODE=0|1|Y|N

Indicates whether the RFC server should use SAP batch jobs for the data extracts.
Y RFC uses batch jobs to extract R/3 data

N RFC uses dialog processes to extract R/3 data

The default value for this option is N.
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To submit batch requests to the RFC server, an RFC destination and a variant for
ABAP program /SAS/Z_SAS_READ must be set up for each RFC server instance.
Before the RFC server can execute requests as a batch job the following steps must be
performed:

1 Create an RFC server destination. For each RFC server that accesses an SAP
system, a destination must be set up on that SAP system. The program ID and
the gateway information defined in the destination are used to register the RFC
server on an SAP gateway. If two RFC servers are used to read data from one SAP
application server, two RFC destinations must be set up on that SAP application
server.

If gateway information is omitted from the SM59 destination, the batch job is
constrained to run on the R/3 server mentioned in the SAS LIBNAME statement
for the request.

If explicit gateway information is entered in the SM59 destination information,
the batch job is run on any eligible R/3 server as determined by the SAP site batch
configuration.

Omitting the gateway information is typically done in small SAP configurations
such as test, QA, and single-server systems. In production environments, it is
preferable to have the jobs run on a server allocated by the SAP batch system.

2 Create a variant of ABAP program [SAS/Z_SAS_READ. After defining the
destination for the RFC server, you will need to make the RFC destination known
to the ABAP program. This is done by creating a variant for the ABAP program /
SAS/Z_SAS_READ. The concept of variants provides a way of parameterizing
ABAP programs. For each defined destination, a variant needs to be created that
references the destination. Variants are client dependent.

3 Start the RFC server with the variant. For more information about using the RFC
server and particularly the sasrfc server option, see “Using the RFC Server on
UNIX” on page 58 and “Using the RFC Server on Windows NT” on page 62.

For further information about the setup of RFC server destinations and variants, see
the Installation Instructions to SAS/ACCESS Interface to R3.

Using the RFC Macros and Macro Variables

SAS/ACCESS Interface 4.2 to R/3 includes several SAS macros and SAS macro
variables that enable you to communicate with the RFC server. The following SAS
macros and SAS macro variables are available:

%CALLRFC
enables you to call a specified R/3 function. For more information about using the
%CALLRFC macro, see “CALLRFC” on page 66.

%R3CONNB
enables you to use a profile to log on to the R/3 system for batch processing. For
more information about using the R3CONNB macro, see “2R3CONNB” on page
70.

%R3CONNC
enables you to log on to the R/3 system when performing batch processing. For
more information about using the %R3CONNC macro, see “2R3CONNC” on page
71.
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%R3CONNE
enables you to log off of the R/3 system when performing batch processing. For
more information about using the %R3CONNE macro, see “9R3CONNE” on page
74.

RFC_LOGON_INFO
enables you to you to specify the logon information and connection parameters
that are used in the %CALLRFC macro. For more information about using the
RFC_LOGON_INFO macro variable, see “RFC_LOGON_INFO” on page 74.

%GCALLRFC

Calls a specified RFC-enabled R/3 function module

Type: autocall macro

See also:
“Using the R/3 BAPI Connector: Logon Window” on page 76

“RFC_LOGON_INFO” on page 74

Syntax

9%CALLRFC(<RFC-enabled function module name> EXPORTING <parameter string>
IMPORTING <parameter string> INTABLES <parameter string> OUTTABLES
<parameter string> USING <parameter string>)

Details
%CALLRFC is a SAS macro that allows you to call any RFC-enabled R/3 function
module that you specify. Function modules that are called using this macro must
o be RFC-enabled
o be synchronous

O have no user interaction.

The parameters for %CALLRFC are as follows:

EXPORTING passes field values or structures to the specified R/3 function
module. The EXPORTING parameters are declared as import
parameters in the function interface and are defined as follows:

O pl=valuel ... pn=valuen

These parameters are passed as field values to the specified
R/3 function module.

0 pl.nl=value pl.n2=value? ... pn.vn=valuen

These parameters are passed as elements of a structured
parameter (a complex parameter that contains fields).

HOST specifies the network location of the RFC server. The default is
localhost.
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passes field values or structures from the specified R/3 function
module back to SAS. The IMPORTING parameters are defined as
follows:
O pl=varl ... pn=varn
The pI ... pn parameters are export parameters declared in
the function interface.
The varl ... varn parameters are SAS macro variables that
are used to pass the values from the RFC server back to SAS.
The macro variables must be defined before the function call is
submitted.

0 pl=datasetl pn=datasetn

Parameters that are written into a data set require a
two-level data set name. Writing parameters into data sets can
be useful for structured parameters.

passes references to input SAS data sets. The INTABLES
parameters are defined as follows:

O pl=datasetl ... pn=datasetn

The SAS data sets are converted into internal tables and are
passed to the specified function module.

Note: The variable names in the SAS data set must match the
field names of the internal table as they are defined in the
function interface. A

specifies references to output SAS data sets. The OUTTABLES
parameters are defined as follows:

O pl=datasetl ... pn=datasetn

Internal tables passed back to SAS from the specified
function module are converted into SAS data sets.

specifies the TCP/IP port to use for communicating with the RFC
server. The default port number is 6999.

specifies alternate connection parameters when you log on to the R/3
system. By default, the %CALLRFC macro uses the connection
parameters that are defined in the RFC_LOGON_INFO variable.
However, if you want to use an alternate set of connection
parameters, create a variable that contains those parameters and
reference that variable in the USING parameter.

Note: The alternate logon variable must be defined before the
function call is submitted. A

Note: If an error occurs while the #CALLRFC macro is executing, the macro
variables &SYSRC and/or &SYSERR contain nonzero values. (See “Example 4” on page
69.) The ABAP function module might also contain parameters to return error
conditions to the calling program. These return codes can be written into a SAS macro
variable and checked in the SAS program. (See “Example 5” on page 69.) A
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Using
The following macro variables are used with the %CALLRFC macro:
o RFC_LOGON_INFO

defines the R/3 BAPI connection parameters that are required to access the SAP
R/3 system. You can specify these connection parameters by using the
RFC_LOGON_INFO macro string or by using the R/3 BAPI Connector window,
which is automatically displayed if you do not use the RFC_LOGON_INFO macro
string when you submit your %CALLRFC macro statement. The following
connection parameters are required:

o CLIENT

USER

PASSWD (or PASSWDX)
LANG

HOST

PORT

Note: If any of the required values are missing, the user is prompted to
provide the missing information. A

O o o o d

The RFC_LOGON_INFO macro variable also requires some connection
information. The connection parameters should be defined as follows:

0 If you use the saprfc.ini, specify the DEST value.
o If you use a specific application server, specify the ASHOST and SYSNR
values.

0 If you use Load Balancing, specify the MSHOST, RSNAME, and GROUP
values.

Note: Load Balancing is available only if the CALLRFC executable has been
linked using Release 4.0 or higher of the RFCSDK. A

For more information about defining the RFC_LOGON_INFO variable, see
“RFC_LOGON_INFO” on page 74. For more information about using the R/3 BAPI
Connector window, see “Using the R/3 BAPI Connector: Logon Window” on page 76.

Example 1

The following example shows how to use the %CALLRFC macro to read data from an
SAP R/3 system into a SAS data set:

$callrfc(RFC_SYSTEM INFO
IMPORTING RFCSI_EXPORT=WORK.RFCSI_EXPORT) ;

In this example, the %CALLRFC macro calls the RFC-enabled function module named
RFC_SYSTEM_INFO and writes the system information output to the SAS data set
WORK.RFCSI_EXPORT.

Example 2

The following example shows how to specify the logon parameters for the
%CALLRFC macro using the RFC_LOGON_INFO:

glet RFC_LOGON_INFO=CLIENT=010 USER=TestUser
PASSWD=USERPWD LANG=E HOST=localhost PORT=6999
ASHOST=HostName SYSNR=02;
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$callrfc(RFC_SYSTEM INFO
IMPORTING RFCSI_EXPORT=WORK.RFCSI_EXPORT) ;

In this example, TestUser is connecting to a specific application server to read data
from the R/3 system into a temporary SAS data set named WORK.RFCSI_EXPORT.

Example 3

The following example demonstrates how to use SAS dates in the function call:

$let MRETURN=;
%callrfc(BAPI_COSTCENTER_GETLIST
EXPORTING CONTROLLINGAREA=1000
DATE=%sysfunc(date (), yymmddn8.)
IMPORTING RETURN=MRETURN
OUTTABLES COSTCENTER_LIST=WORK.COSTCENTER_LIST);

In this example, the %CALLRFC macro is used to call the function module named
BAPI_COSTCENTER_GETLIST. The function call reads the list of cost centers for
controlling area 1000 for the current date and writes the output list into a temporary
SAS data set named WORK.COSTCENTER_LIST. The return code of the function call
is written to the SAS macro variable MRETURN. Note that the macro variable is
defined before the %CALLRFC macro is used.

Example 4

The following example illustrates how to use the &SYSRC and &SYSERR macro
variables to check for errors that occur while the %#CALLRFC macro is executing:

gmacro exampled;
%callrfc(INVALID_FUNCTION_CALL);

%if %eval(&sysrc) ne 0 or %eval(&syserr) ne 0 %then %do;
$put An error occurred while calling the function.
$put SySrc=&SysSrc SySerr=&syserr;

%end;

gmend;
$exampled;

In this example, a new macro named %#EXAMPLEA4 is created. % EXAMPLE4 uses the
SAS macro variables &SYSRC and &SYSERR to check return codes from the
%CALLRFC macro. The new macro also generates an error message if errors occurred.

Example 5

The following example shows how to use the parameters in the function module to
check for errors that occurred during the execution of the %CALLRFC macro:

$macro example5;
%global bapi_return;

/* create the input data set */
data WORK.IDRANGE;
sign='1";
option='BT';
low='"0000000000";
high=79999999999";
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output;
run;

%callrfc(BAPI_CUSTOMER_GETLIST
IMPORTING RETURN=BAPI_ RETURN
INTABLES IDRANGE=WORK.IDRANGE
OUTTABLES ADDRESSDATA=WORK.ADDRESSES) ;
$if %substr(&bapi_ return,1,1)=E or
$substr(&bapi_return,1,1)=W %then %do;
%put An error occurred while calling the BAPI_CUSTOMER_GETLIST function.;
%put bapi_return=&bapi_return;
%end;

%else %do;
proc print data=WORK.ADDRESSESs;
run;

%end;

gmend;

$example5;

In this example, a new macro named %EXAMPLES5 is created to retrieve a list of
customers from the R/3 system. The range of customer numbers to be retrieved is
specified in the SAS data set WORK.IDRANGE. This data set is then used as the input
table in the function call. The information for customers between customer number
0000000000 and 9999999999 will be read into the SAS data set WORK. ADDRESSES.
The function parameters contain return codes and messages from the
BAPI_CUSTOMER_GETLIST function. The structure of the return parameter is
defined in the function interface. In this example, the first character in the return
string contains the message type. E indicates an error message and W indicates a
warning message.

%R3CONNB

Connects to or disconnects from an R/3 system using a profile

Type: batch macro

Syntax

9%R3CONNB(PROFILE=value, LIBREF=value, FUNCTION=o0pen | close, ID=value,
SOURCE=value)

Details

The %R3CONNB macro allows you to log on to and log off of the R/3 system using
parameters stored in the data set LIBREF.R3CONN under the profile name. Profiles
that connect to and disconnect from the R/3 system can be used for batch operation,
such as overnight processing, and to simplify the logon process for end users.

The parameters for %R3CONNB are as follows:
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PROFILE identifies the name of the profile that contains the information used
in the Logon to R/3 window.

LIBREF identifies the SAS library containing the LIBREF.R3CONN data set.
This data set contains the logon parameters defined for the profile.

FUNCTION specifies whether you want to open or close the connection to the R/3
system. Valid values are
o OPEN
o CLOSE

ID specifies the connection ID that is associated with the profile.

Note: This parameter was defined for previous versions of this
macro and is supported in this release for backward compatibility.
However, it is recommended that this parameter not be used. A

SOURCE specifies the logon parameters that are defined in SOURCE type
catalog entries. Although the SOURCE parameter is supported in
this version, logon parameters should now be defined in profiles that
are stored in a SAS data set.

Note: This parameter was defined for previous versions of this
macro and is supported in this release for backward compatibility.
However, it is recommended that this parameter not be used. A

Example 1

The following example shows how to use the %#R3CONNB macro to connect to the
R/3 system using a profile:

$r3connb (PROFILE=BatchUser, LIBREF=batch, FUNCTION=open);

In this example, the profile BatchUser is used to connect to the R/3 system. The
BatchUser profile uses the connection parameters stored in the BATCH.R3CONN data
set.

Example 2

The following example shows how to use the %#R3CONNB macro to disconnect from
the R/3 system by using a profile:

$r3connb (PROFILE=BatchUser, LIBREF=batch, FUNCTION=close);

The BatchUser profile was used to connect to the R/3 system. This example
demonstrates how to use the %R3CONNB macro to close the BatchUser profile’s
connection to the R/3 system.

%R3CONNC

Connects to an R/3 system

Type: batch macro
See also: “%R3CONNE” on page 74
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Syntax

%R3CONNC(CCONN=value, HOST=value, PORT=value, USR=value, PWD=value,
CLI=value, LNG=value, HST=value, DST=value, SNA=value, R3=value,
SYS=value, GWS=value, GWH=value, FUNC=value, CPICUSR=value,
CPICPWD=value, CPICCLI=value, CPICLNG=value, CPICDST=value,
CPICFRM=value, DEBUG=value, REMSESS=value)

Details

The %R3CONNC macro allows you to connect to an R/3 system. This macro can be
used to log on to the R/3 system during batch operation.
The parameters for %R3CONNC are as follows:

CCONN

HOST

PORT

USR

PWD

CLI
LNG
HST

DST

SNA

R3

SYS

GWS

GWH

FUNC
CPICUSR
CPICPWD

specifies the connection identifier to be used when connecting to the
R/3 system.

specifies the name of the TCP/IP host to be used when connecting to
the RFC server.

specifies the TCP/IP port to be used when connecting to the RFC
server.

specifies the R/3 user ID to be used when connecting to the R/3
system.

specifies the encoded R/3 password to be used when connecting to
the R/3 system.

specifies the R/3 client to be used with the R/3 system.
specifies the R/3 logon language to be used with the R/3 system.

specifies the R/3 host name to be used when connecting to the R/3
system.

specifies the R/3 destination name to be used when using the
SIDEINFO file to specify connection parameters.

specifies whether the RFC server connects to an R/2 system. Valid
values are

0 Y — RFC server connects to an R/2 system.

0 blank — RFC server is not connecting to an R/2 system.
specifies whether the RFC server is connecting to an R/3 system.
Valid values are

0 Y — RFC server is connecting to an R/3 system.

0 blank — RFC server is not connecting to an R/3 system.

specifies the R/3 system number. This parameter can be specified
here or in the SIDEINFO file.

specifies the TCP service of the SAP gateway. This parameter can be
specified here or in the SIDEINFO file.

specifies the name of the host on which the SAP gateway is running.
This parameter can be specified here or in the SIDEINFO file.

specifies the R/3 function module to be used.
specifies the R/3 user identifier for CPIC.
specifies the encoded R/3 password for CPIC.
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CPICCLI specifies the R/3 client for CPIC.

CPICLNG specifies the R/3 logon language for CPIC.

CPICDST specifies the destination for CPIC communication (as defined in the
TXCOM table in the R/3 system).

CPICFRM specifies the form for CPIC.

DEBUG specifies whether you want to use the trace option. Valid values are

0 Y — Use the trace option.

0 blank — Do not use the trace option.

REMSESS specifies the SAS/CONNECT remote session ID to be used when
connecting to the R/3 system.

Note: The SIDEINFO file provides the connection parameters required for the RFC
server to communicate with the R/3 system. The SIDEINFO file is not needed if you
specify all connection parameters in the %RCONNC macro. A

Example 1

The following example shows how to use the %#R3CONNC macro to connect to an R/3
system when you specify a specific application server:

%r3connc (CCONN=IDES, USR=USER1, PWD=D27A927AD9E768,
CLI=800, LNG=EN, HST=HostNamel, SYS=02,
CPICUSR=CPICUSER, CPICPWD=6FD3E4BAC4);

In this example, USERI1 is connecting to an R/3 system on an application server named
HostNamel with a system number of 02.

Example 2

The following example shows how to use the %#R3CONNC macro to connect to an R/3
system and an RFC server that runs on a specified application server:

%r3connc (CCONN=IDES, USR=USER1, PWD=D27A927AD9E768, CLI=800, LNG=EN,
HOST=HostName2, PORT=6998,
HST=HostNamel, SYS=02,
CPICUSR=CPICUSER, CPICPWD=6FD3E4BAC4);

In this example, SAS connects to an R/3 application server (HostNamel) with the
system number of 02 using an RFC server running on a separate host (HOSTNAMEZ2)
on port 6998.

Example 3

The following example shows how to use the %#R3CONNC macro and a SIDEINFO
file to connect to an R/3 system identified by a logical destination:

%r3connc (CCONN=IDES, USR=USER1, PWD=D27A927AD9E768,
CLI=800, LNG=EN, DST=SYSTEMI,
CPICUSR=CPICUSER, CPICPWD=6FD3E4BAC4);

In this example, USERI1 is connecting to an R/3 system. The R/3 system is identified by
a logical destination (SYSTEM]1), and the connection information is defined in the
SIDEINFO file.
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%R3CONNE

Disconnects from an R/3 system

Type: batch macro
See also: “%R3CONNC” on page 71

Syntax
%R3CONNE(CCONN=value, REMSESS=value)

Details

The %R3CONNE macro allows you to disconnect from the R/3 system. This macro can
be used to log out of the R/3 system during batch operation.
The parameters for %R3CONNE are as follows:

CCONN specifies the connection identifier that is associated with the current
session.
REMSESS specifies the SAS/CONNECT remote session identifier that is

associated with the current remote session.

Example

The following example shows how to use the %#R3CONNE macro to disconnect from
an R/3 system:

$r3conne (CCONN=IDES) ;

In this example, the %R3CONNE macro is used to terminate the R/3 connection with
an ID of IDES.

RFC_LOGON_INFO

Defines the connection parameters that are required to access the SAP R/3 system

Type: optional macro variable
Applies to: %CALLRFC macro

See also:
“%wCALLRFC” on page 66

“Using the R/3 BAPI Connector: Logon Window” on page 76

Syntax
%let RFC_LOGON_INFO=ID=value ID=value ... ID=value

Note: Values are case-sensitive. IDs are not. A
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Details

RFC_LOGON_INFO is a macro variable that is used with the %2CALLRFC macro. The
RFC_LOGON_INFO variable uses the following parameters:

Parameter ID Description

TYPE identifies the type of RFC server. Valid values are
2 - identifies an R/2 server
3 - (default) identifies an R/3 server

E - identifies an external server.

CLIENT is a required value that identifies the SAP logon client.
USER is a required value that specifies the SAP user logon ID.
PASSWD is a required value that identifies the SAP logon password.

This value is not required if a PASSWDX value is specified.
LANG is a required value that identifies the SAP logon language. Specify the
1-byte SAP language (E for English, D for German, etc.)
2-byte ISO language (EN for English, DE for German, etc.)
LCHECK specifies the logon check option at OPEN time. Valid values are
0 - logon without check
1 - (default) logon with check.
TRACE specifies the RFC trace option. Valid values are
0 - (default) without trace
1 - with trace.

DEST identifies the logical destination in the saprfc.ini file, if applicable. When you
use an R/2 RFC server, you must also define this destination in the SIDEINFO
file for the SAP gateway.

This value is required when you use the saprfe.ini.

GWHOST specifies the host name of the SAP gateway if you use an R/2 or external RFC
server.

GWSERV identifies the service of the SAP gateway if you use an R/2 or external RFC
server.

MSHOST specifies the host name of the message server if you use Load Balancing.

This value is required if you use Load Balancing.
R3NAME specifies the name of the R/3 system if you use Load Balancing.
This value is required if you use Load Balancing.
GROUP specifies the name of the group of application servers if you use Load Balancing.
This value is required if you use Load Balancing.
ASHOST identifies the host name of the specific application server to be used.
This value is required if you use a specific application server.

SYSNR identifies the R/3 system number if you use a specific application server and do
not use Load Balancing.

This value is required if you use a specific application server.
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Parameter ID Description

ABAP_DEBUG specifies the ABAP debugger option. Valid values are
0 - (default) run without the ABAP debugger
1 - run with the ABAP debugger.
Note: If you use the ABAP_DEBUG option, the SAP GUI must be installed.

PASSWDX identifies the SAS-encrypted SAP logon password.

Example 1

The following example shows how to specify logon information for the %CALLRFC
macro using the RFC_LOGON_INFO macro variable:

glet RFC_LOGON_INFO CLIENT=010 USER=USER1
PASSWD=USERPWD LANG=E
MSHOST=HostName R3NAME=BIN GROUP=Public;
$callrfc(RFC_SYSTEM INFO
IMPORTING RFCSI_EXPORT=WORK.RFCSI_EXPORT) ;

In this example, USERI1 is connecting to a server that uses Load Balancing to read R/3
data into a temporary data set called WORK.RFCSI_EXPORT.

Example 2

The following example shows how to specify logon information for the %CALLRFC
macro using the RFC_LOGON_INFO macro variable:

glet RFC_LOGON_INFO=CLIENT=010 USER=USER1
PASSWD=USERPWD LANG=E
ASHOST=HostName SYSNR=02;
$callrfc(RFC_SYSTEM INFO
IMPORTING RFCSI_EXPORT=WORK.RFCSI_EXPORT) ;

In this example, USERI1 is connecting to a specific application server to read R/3 data
into a temporary data set called WORK.RFCSI_EXPORT.

Using the R/3 BAPI Connector: Logon Window

The R/3 BAPI Connector: Logon window is automatically displayed if you do not use
the RFC_LOGON_INFO macro string when you submit your %CALLRFC macro
statement. The R/3 BAPI Connector: Logon window enables you to define the R/3 BAPI
connection parameters that are required to access the SAP R/3 system.
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Display 5.1 R/3 BAPI Connector: Logon Window

H—;EI_F”? BAFPI Connector: Logon M= &=

Clignt:

Uzer:
Pazzward:
Language:
Destination:
Host:

System number:
Gateway host:

Gateway service:

CK |

Cancel |

Help |

For more information about the %CALLRFC macro, see “%CALLRFC” on page 66.
For more information about using the RFC_LOGON_INFO macro string, see
“RFC_LOGON_INFO” on page 74.

The following fields are available on the R/3 BAPI Connector: Logon window:

Client
User
Password

Language

Destination

Host

System number

Gateway host

Gateway
service

enables you to identify the SAP logon client. This field is required.
enables you to identify the SAP user logon ID. This field is required.
enables you to enter the SAP user password. This field is required.

enables you to specify the SAP logon language. Specify the 1-byte
SAP language (E for English, D for German, and so on) or the
2-byte ISO language (EN for English, DE for German, and so on).
This field is required.

enables you to identify the logical destination of the saprfc.ini file, if
applicable. When you use an R/2 RFC server, you must also define
this information in the sideinfo file for the SAP gateway. This field
is required if you use the saprfc.ini. For more information about the
sideinfo file, see “Sideinfo File” on page 22.

enables you to identify the application server host. This field is
required if a specific application server will be used.

enables you to identify the R/3 system number if you are using a
specific application server and are not using Load Balancing. This
field is required if you use a specific application server.

enables you to identify the host name of the SAP gateway if you use
an R/2 or external RFC server.

enables you to identify the service of the SAP gateway if you use an
R/2 or external RFC server.

The following buttons are available on the R/3 BAPI Connector: Logon window:

submits the R/3 BAPI connection parameters that you entered and
attempts to log on to the R/3 system.
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closes the R/3 BAPI Connector: Logon window without submitting
the connection paramaters and attempting to logon to the R/3
system.

displays the SAS Help for the window.
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Overview of the LIBNAME Engine for SAP

The SAP LIBNAME engine is a read-only engine that allows you to access tables and
views from SAP R/3 and SAP BW systems. The SAP LIBNAME engine accesses an SAP
system through a connection to the SAS RFC server and is part of the SAS solution to
access data in a SAP system. When a connection to the SAP system is successfully
established and you are logged on to the system, the RFC server sends system
information back to the LIBNAME engine.

The 9.1 SAP LIBNAME engine supports new features such as load balancing, user
validation at log on, more efficient handling of projections, and server-side joins.
Directory processing is also supported.

Note: Unlike other library engines, these interfaces are read-only and do not
support any forms of data set creation, deletion, or modification. 2

LIBNAME Statement Syntax for SAP

LIBNAME [ibref R3 <Options>;

libref specifies a valid SAS name that serves as an alias to associate SAS
with the SAP tables and view. It is any SAS name when you are
assigning a new libref.

R3 explicitly specifies the R/3 library engine.
<Options> names one or more options honored by the R/3 engine, delimited
with blanks.

The SAP LIBNAME statement assigns a library and allows the SAP engine to
establish the connection to the SAP system. It checks (by default) the logon information
including: user, password, language, and client. This is done by establishing the
connection to the RFC server and sending the logon information to the RFC server.

A user specifies a LIBNAME statement for the engine, and then can use that libref
throughout SAS, wherever a libref is valid.
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SAP LIBNAME Engine Options

The following LIBNAME options apply to the SAP LIBNAME Engine.
ABAPFM=“ABAPFM-= abap_function_name “on page 80
ABAPPROG=“ABAPPROG= abap_program “on page 81
ASHOST=“ASHOST= application_server_host” on page 81
BATCH="BATCH=0|1|Y|N ”on page 81

CLIENT=“CLIENT= client” on page 82
DESTINATION=“DESTINATION= destination” on page 82
GROUP=“GROUP= application_server_group “on page 83
GWHOST=“GWHOST= gateway_host_name ”on page 83
GWSERV=“"GWSERV= gateway_service "on page 83
HOST=“HOST= rfc_server_host” on page 84
IEEE_REVERSE=“IEEE_REVERSE= Y |N” on page 84
INENCODING =“INENCODING = code_page” on page 84
LANGUAGE =“LANGUAGE = language” on page 85
MAX_TABLE_JOINS =“MAX_TABLE_JOINS = number ”on page 85
MSHOST="MSHOST= message_server_host “on page 85
NUMC_SAS_TYPE =“NUMC_SAS_TYPE = N|C|$” on page 86
PASSWORD=“PASSWORD= password” on page 86
PASSWORDX=“PASSWORDX= encrypted-password” on page 87
PORT=“PORT= rfc_server_port "on page 87
R3NAME=“R3NAME= system_name “on page 87
RFC_STRING=“RFC_STRING= additional_rfc_options “on page 88
SAPLOGON_ID=“SAPLOGON_ID= saplogon_id” on page 88
SYSNR=“SYSNR= system_number” on page 88

TRACE=“TRACE= 0 |1|Y|N” on page 89

USER=“USER= user” on page 89

ABAPFM= abap_function_name

Indicates the name of the ABAP function module that the RFC server uses internally

Valid in:.  SAS/ACCESS LIBNAME statement for SAP
Default value: /SAS/Z_SAS_DIALOG

Syntax

ABAPFM | ABAPFUNCTION | ABAPFUNC = abap_function_name
Indicates the name of the ABAP function module that the RFC server uses internally.
The default value for this option is /SAS/Z_SAS_DIALOG and is set by the RFC server.
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ABAPPROG= abap_program

Indicates the name of the ABAP program that the RFC server uses internally

Valid in: SAS/ACCESS LIBNAME statement for SAP
Default value: /SAS/Z_SAS_READ

Syntax

ABAPPROG | ABAPREPORT |ABAPPROGRAM = abap_program

Indicates the name of the ABAP program that the RFC server uses internally. The
default value for this option is /SAS/Z_SAS_READ and is set by the ABAP function
module.

ASHOST= application_server_host

Indicates the host name or IP address of a specific SAP application server

Valid in: SAS/ACCESS LIBNAME statement for SAP
Default value: none

Syntax

ASHOST| HST |RFCHOST |R3HOST = application_server_host
Indicates the host name or IP address of a specific SAP application server.

BATCH= OI1IYIN

Indicates whether the RFC server should use SAP batch jobs for the data exiracts

Valid in:. SAS/ACCESS LIBNAME statement for SAP
Default value: N

Syntax
BATCH | BATCH_MODE | BATCHMODE = 0|1|Y|N
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Y
specifies that the RFC uses batch jobs to extract R/3 data.

N
specifies that the RFC uses dialog processes to extract R/3 data.

Indicates whether the RFC server should use SAP batch jobs for the data extracts.
The default value for this option is N.

CLIENT= client

Specifies the SAP logon parameter client

Valid in: SAS/ACCESS LIBNAME statement for SAP
Default value: SAP system default

Syntax

CLIENT| CLI | RFCCLIENT | RFCCLI = client

Indicates the SAP logon parameter client. Examples for a client are 000 or 800. The
default value for this option is the SAP system default. When accessing the SAP R/3
system or the SAP BW system via the LIBNAME engine, you must specify valid logon
information including client, user name, password, and language. The RFC server
performs a logon check at OPEN time.

DESTINATION= destination

Indicates the destination in saprfc.ini if working with saprfc.ini

Valid in:.  SAS/ACCESS LIBNAME statement for SAP
Default value: none

Syntax

DESTINATION | DEST| DST | DSTN = destination

Indicates the destination in saprfc.ini if working with saprfec.ini. If the RFC server is
an R/3 system, then this destination must also be defined in the SIDEINFO file for the
SAP gateway.
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GROUP= application_server_group

Indicates the name of the group of SAP application servers

Valid in: SAS/ACCESS LIBNAME statement for SAP
Default value: none

Syntax

GROUP= application_server_group
Indicates the name of the group of SAP application servers if using load balancing.

GWHOST= gateway_host_name

Indicates the host name of the SAP gateway

Valid in:. SAS/ACCESS LIBNAME statement for SAP
Default value: none

Syntax

GWHOST | GATEWAY_HOST = gateway_host_name
Indicates the host name of the SAP gateway.

GWSERV= gateway_service

Indicates the service of the SAP gateway

Valid in: SAS/ACCESS LIBNAME statement for SAP
Default value: none

Syntax

GWSERV | GATEWAY_SERVICE = gateway_service
Indicates the service of the SAP gateway.
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HOST= rfc_server_host

Indicates the host of the RFC server to be used to connect to the SAP system

Valid in:.  SAS/ACCESS LIBNAME statement for SAP
Default value: localhost

Syntax

HOST | RFC_SERVER_HOST | RFC_SERVER | SASRFC_SERVER |
SASRFC_SERVER_HOST = rfc_server_host
Indicates the host of the RFC server to be used to connect to the SAP system. The
default value for this option is localhost.

IEEE_REVERSE= YIN

Indicates whether floating point numbers are byte reversed

Valid in:  SAS/ACCESS LIBNAME statement for SAP
Default value: Y or N depending on platform

Syntax
IEEE_REVERSE = Y|N

Y
Indicates that floating point numbers are byte reversed.

N
Indicates that floating point numbers are not byte reversed.

Indicates whether floating point numbers are byte reversed. The default value for
this option is Y for an R/3 application server on Windows NT, and N for the other
platforms.

INENCODING = code_page

Indicates the code page

Valid in:.  SAS/ACCESS LIBNAME statement for SAP
Default value: none

Syntax
INENCODING = code_page
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Indicates the code page. The code page identifies characters and symbols that can be
printed, displayed on terminals, and used in SAP programs.

LANGUAGE = language

Indicates the SAP logon parameter language

Valid in:. SAS/ACCESS LIBNAME statement for SAP
Default value: SAP system default

Syntax

LANGUAGE | LANG | LNG |RFCLANG |RFCLNG = language

Indicates the SAP logon parameter language. The value for language is either the
2-byte ISO-language key or the 1-byte SAP language. Examples for the language
include EN, DE or E, D. The default value for this option is the SAP system default.
When accessing the SAP R/3 system or the SAP BW system via the LIBNAME engine,
you must specify valid logon information including client, user name, password and
language. The RFC server performs a logon check at OPEN time.

MAX_TABLE_JOINS = number
Indicates the number of tables that can be used in a left-outer join or an inner join in ABAP Open
saL

Valid in: SAS/ACCESS LIBNAME statement for SAP
Default value: 25

Syntax

MAX_TABLE_JOINS | MAX_TABLES_JOIN | MAX_TABLES_JOINS
| MAX_TABLE_JOIN = number
Indicates the number of tables that can be used in a left-outer join or an inner join in
ABAP Open SQL. The default value for this option is 25.

MSHOST= message_server_host

Indicates the host name of the message server
Valid in:. SAS/ACCESS LIBNAME statement for SAP

Default value: none
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Syntax

MSHOST= message_server_host
Indicates the host name of the message server (if using load balancing).

NUMC_SAS_TYPE = NICI$

Indicates the SAS type for ABAP type NUMC

Valid in: SAS/ACCESS LIBNAME statement for SAP
Default value: C

Syntax
NUMC_SAS_TYPE | NUMC_SASTYPE | NUMC_TYPE |[NUMC = N|C|$

N
Number

C
Character

$

Character

Indicates the SAS type for ABAP type NUMC. The default is C.

PASSWORD= password

Indicates the SAP logon parameter password

Valid in: SAS/ACCESS LIBNAME statement for SAP
Default value: none

Syntax

PASSWORD | PASSWD |PWD |PW | PASS = password

Indicates the SAP logon parameter password. When accessing the SAP R/3 system or
the SAP BW system via the LIBNAME engine, you must specify valid logon information
including client, user name, password and language. The RFC server performs a logon
check at OPEN time.
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PASSWORDX= encrypted-password

Indicates the SAP logon parameter password in an encrypted form

Valid in: SAS/ACCESS LIBNAME statement for SAP
Default value: none

Syntax

PASSWORDX | PASSWDX |PWDX |PWX | PASSX= encrypted password

Indicates the SAP logon parameter password in an encrypted form. It uses the
encryption type that is used in the SAS/ACCESS Interface to R/3, Version 8. It is
supported for compatibility with the Version 8 connection profile.

PORT= ric_server_port

Indicates the port number of the RFC server to be used to connect to the SAP system

Valid in:. SAS/ACCESS LIBNAME statement for SAP
Default value: 6999

Syntax

PORT | RFC_SERVER_PORT | RFCSERVERPORT | SASRFC_SERVER_PORT |
SASRFCSERVERPORT = rfc_server_port
Indicates the port number of the RFC server to be used to connect to the SAP
system. The default value for this option is 6999.

R3NAME= system_name

Indicates the name of the R/3 system

Valid in: SAS/ACCESS LIBNAME statement for SAP
Default value: none

Syntax

R3NAME= system_name
Indicates the name of the R/3 system (if using load balancing).
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RFC_STRING= additional_rfc_options

Indicates additional logon or connection parameters for the RfcOpenEx() call

Valid in:.  SAS/ACCESS LIBNAME statement for SAP
Default value: none

Syntax

RFC_STRING | RFCSTRING | RFC_OPTIONS_EXT | RFCOPENEX |
ADDITIONAL_RFC_OPTIONS = additional_rfc_options
Indicates additional log on or connection parameters for the RfcOpenEx() call. The
RFC server uses the RfcOpenEx() call to log on to the SAP system. With this option,
parameters that are not LIBNAME options can be passed to the RfcOpenEx() call.

RFC_STRING Example

RFC_STRING = "ABAP_DEBUG=1"

Note: When using RFC_STRING="ABAP_DEBUG=1", the ABAP debugger is
invoked to debug the ABAP programs used by the engine. The SAP GUI on the RFC
server host is required to use the ABAP_DEBUG=1 option. A

SAPLOGON_ID= saplogon_id

Indicates the string defined for SAPLOGON on 32-bit Windows

Valid in:.  SAS/ACCESS LIBNAME statement for SAP
Default value: none

Syntax

SAPLOGON_ID= saplogon_id
Indicates the string defined for SAPLOGON on 32-bit Windows.

SYSNR= system_number

Indicates the R/3 system number

Valid in:  SAS/ACCESS LIBNAME statement for SAP
Default value: none

Syntax
SYSNR |SYS |SYSTEM |SYSNO = system_number
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Indicates the R/3 system number. It is the 2-byte code that identifies the system on
the host. For example: 00 or 01.

TRACE= 0 I1IYIN

Indicates whether the RFC server should trace the requests

Valid in: SAS/ACCESS LIBNAME statement for SAP

Default value: O

Syntax
TRACE=0 |1|Y|N

0
Specifies that RFC trace is switched off.

1
Specifies that RFC trace is switched on.

Y
Specifies that RFC trace is switched on.

N
Specifies that RFC trace is switched off.

Indicates whether the RFC server should trace the requests. If the trace option is
switched on, the RFC server writes log information into a file. The RFC library logs
messages in the file dev_rfc. The default value for this option is 0.

USER= user

Indicates the SAP logon parameter user.

Valid in:. SAS/ACCESS LIBNAME statement for SAP

Default value: none

Syntax

USER | USR |RFCUSER |USERNAME |USERID= user

When accessing the SAP R/3 system or the SAP BW system via the LIBNAME
engine, you must specify valid logon information including the client, user name,
password, and language. The RFC server performs a logon check at OPEN time.
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SAS LIBNAME Statement Options for the SAP Engine

The following list describes the SAP interface support for SAS /ACCESS LIBNAME
options and presents default values where applicable. For further information, refer to
the SAS/ACCESS 9.1 for Relational Databases: Reference.

CONNECTION=“CONNECTION= LIBNAME Option” on page 90
CONNECTION_GROUP=“CONNECTION_GROUP= LIBNAME Option” on page 91
DBGEN_NAME=“DBGEN_NAME= LIBNAME Option” on page 91
DBPROMPT=“DBPROMPT= LIBNAME Option” on page 92
DBSASLABEL=“DBSASLABEL= COMPAT | NONE | DBMS ”on page 92
DEFER=“DEFER= LIBNAME Option” on page 93

DIRECT_SQL=“DIRECT_SQL= LIBNAME Option” on page 93
MULTI_DATASRC_OPT=“MULTI_DATASRC_OPT= LIBNAME Option” on page 94
REREAD_EXPOSURE=“REREAD_EXPOSURE= LIBNAME Option” on page 94
SPOOL=“SPOOL= LIBNAME Option” on page 95

CONNECTION= LIBNAME Option

Specifies whether operations against a single libref share a connection to the DBMS, and whether

operations against multiple librefs share a connection to the DBMS

Valid in:  SAS/ACCESS LIBNAME statement

DBMS support: DB2 0S/390, DB2 UNIX/PC, Informix, ODBC, OLE DB, Oracle,
Microsoft SQL Server, SYBASE, Teradata, SAP

Default value: DBMS-specific. The default value for SAP is SHAREDREAD

Syntax
CONNECTION= SHAREDREAD | UNIQUE | GLOBALREAD |

For more information about the CONNECTION= option, see the LIBNAME
statement for relational databases in the SAS/ACCESS 9.1 for Relational Databases:
Reference.
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CONNECTION_GROUP= LIBNAME Option

Causes operations against multiple librefs to share a connection to the DBMS. Also causes
operations against multiple pass-through facility CONNECT statements to share a connection to the
DBMS

Valid in: SAS/ACCESS LIBNAME statement

DBMS support: DB2 0S/390, DB2 UNIX/PC, Informix, ODBC, OLE DB, Oracle,
Microsoft SQL Server, SYBASE, Teradata

Default value: none

Syntax
CONNECTION_GROUP= connection-group-name

For more information about the CONNECTION_GROUP= option, see the LIBNAME
statement for relational databases in the SAS/ACCESS 9.1 for Relational Databases:
Reference.

DBGEN_NAME= LIBNAME Option

Specifies whether to automatically rename DBMS columns containing characters that SAS does not
allow, such as $, to valid SAS variabhle names
Valid in:  SAS/ACCESS LIBNAME statement

DBMS support: DB2 0S/390, DB2 UNIX/PC, Informix, ODBC, OLE DB, Oracle,
Microsoft SQL Server, SYBASE, Teradata

Default value: DBMS

Syntax
DBGEN_NAME= DBMS | SAS

For more information about the DBGEN_NAME-= option, see the LIBNAME
statement for relational databases in the SAS/ACCESS 9.1 for Relational Databases:
Reference.



92

DBPROMPT= LIBNAME Option A Chapter 6

DBPROMPT= LIBNAME Option

Specifies whether SAS displays a window that prompts the user to enter DBMS connection
information prior to connecting to the DBMS in interactive mode
Valid in:.  SAS/ACCESS LIBNAME statement

DBMS support: DB2 UNIX/PC, Informix, ODBC, Oracle, Microsoft SQL Server,
SYBASE, Teradata

Default value: NO

Syntax
DBPROMPT=YES | NO

For more information about the DBPROMPT= option, see the LIBNAME statement
for relational databases in the SAS/ACCESS 9.1 for Relational Databases: Reference.

DBSASLABEL= COMPAT | NONE | DBMS

Indicates to the engine what column labels the application expects to be returned

Valid in:.  SAS/ACCESS LIBNAME statement for SAP
Default value: COMPAT

Syntax
DBSASLABEL= COMPAT | NONE

COMPAT specifies that the column labels are compatible with the engine’s
behavior in previous SAS releases. The SAP engine returns the
short descriptive text for the columns of the SAP table. It reads the
column label from the SAP data dictionary. This is the default value.

NONE specifies that no column label information is returned.

For more information about the DBPROMPT= option, see the LIBNAME statement
for relational databases in the SAS/ACCESS 9.1 for Relational Databases: Reference.
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DEFER= LIBNAME Option

Specifies when the connection to the DBMS occurs

Valid in: SAS/ACCESS LIBNAME statement

DBMS support: DB2 0S/390, DB2 UNIX/PC, Informix, ODBC, OLE DB, Oracle,
Microsoft SQL Server, SYBASE, Teradata

Default value: NO

Syntax
DEFER= NO | YES

For more information about the DEFER= option, see the LIBNAME statement for
relational databases in the SAS/ACCESS 9.1 for Relational Databases: Reference.

DIRECT_SQL= LIBNAME Option

Enables you to specify whether generated SQL is passed to the DBMS for processing

Valid in:. SAS/ACCESS LIBNAME statement

DBMS support: DB2 0S/390, DB2 UNIX/PC, Informix, ODBC, OLE DB, Oracle,
Microsoft SQL Server, SYBASE, Teradata

Default value: YES

Syntax

DIRECT_SQL= YES | NO | NONE | NOGENSQL | NOWHERE |NOFUNCTIONS
| NOMULTOUTJOINS

For more information about the DIRECT_SQL= option, see the LIBNAME statement
for relational databases in the SAS/ACCESS 9.1 for Relational Databases: Reference.
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MULTI_DATASRC_OPT= LIBNAME Option

Used in place of DBKEY to improve performance when processing a join between two data sources

Valid in:  SAS/ACCESS LIBNAME statement

DBMS support: DB2 0S/390, DB2 UNIX/PC, Informix, ODBC, OLE DB, Oracle,
Microsoft SQL Server, SYBASE, Teradata

Default value: NONE

Syntax
MULTI_DATASRC_OPT=NONE |IN_CLAUSE

For more information about the MULTI_DATASRC_OPT= option, see the LIBNAME
statement for relational databases in the SAS/ACCESS 9.1 for Relational Databases:
Reference.

REREAD_EXPOSURE= LIBNAME Option

Specifies whether the SAS/ACCESS engine behaves like a random access engine for the scope of
the LIBNAME statement
Valid in:.  SAS/ACCESS LIBNAME statement

DBMS support: DB2 0S/390, DB2 UNIX/PC, Informix, ODBC, OLE DB, Oracle,
Microsoft SQL Server, SYBASE, Teradata

Default value: NO

Syntax
REREAD_EXPOSURE= NO | YES

For more information about the REREAD_EXPOSURE= option, see the LIBNAME
statement for relational databases in the SAS/ACCESS 9.1 for Relational Databases:
Reference.
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SPOOL= LIBNAME Option

Specifies whether SAS creates a utility spool file during read transactions that read data more
than once

Valid in:. SAS/ACCESS LIBNAME statement

DBMS support: DB2 0S/390, DB2 UNIX/PC, Informix, ODBC, OLE DB, Oracle,
Microsoft SQL Server, SYBASE, Teradata

Default value: YES

Syntax
SPOOL= YES | NO

For more information about the SPOOL= option, see the LIBNAME statement for
relational databases in the SAS/ACCESS 9.1 for Relational Databases: Reference.

SAS Data Set Options for the SAP Engine

The following list describes the SAP interface support for SAS /ACCESS data set
options and presents default values where applicable. For further information, refer to
the SAS/ACCESS 9.1 for Relational Databases: Reference

BATCH="BATCH=0|1|Y|N ”on page 95
DBCONDITION=“DBCONDITION= Data Set Option” on page 96
DBGEN_NAME=“DBGEN_NAME= Data Set Option” on page 96
DBKEY=“DBKEY= Data Set Option” on page 97

DBMASTER=“DBMASTER= Data Set Option” on page 97
NULLCHAR=“NULLCHAR= Data Set Option” on page 98
NULLCHARVAL=“NULLCHARVAL= Data Set Option” on page 98
REREAD_EXPOSURE=“REREAD_EXPOSURE= Data Set Option” on page 99

BATCH= OI1IYIN

Indicates whether the RFC server should use SAP batch jobs for the data exiracts

Valid in: SAS/ACCESS LIBNAME statement for SAP
Default value: N

Syntax
BATCH | BATCH_MODE | BATCHMODE = 0[1|Y|N
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Y
RFC uses batch jobs to extract R/3 data.

N

RFC uses dialog processes to extract R/3 data.

Indicates whether the RFC server should use SAP batch jobs for the data extracts.
The default value for this option is N.

Note: The BATCH= option is SAP specific. A

DBCONDITION= Data Set Option

Specifies criteria for subsetting and ordering DBMS data
Valid in:. DATA and PROC steps (when accessing DBMS data using SAS/ACCESS

software)

DBMS support: DB2 0S/390, DB2 UNIX/PC, Informix, ODBC, OLE DB, Oracle, Microsoft
SQL Server, SYBASE, Teradata

Default value: none

Syntax
DBCONDITION="DBMS-SQL-query-clause"

For more information about the DBCONDITION= option, see the data set options for
relational databases section in the SAS/ACCESS 9.1 for Relational Databases:
Reference.

DBGEN_NAME= Data Set Option

Specifies whether to rename columns automatically when they contain characters that SAS does
not allow

Valid in:.  DATA and PROC steps (when accessing DBMS data using SAS/ACCESS
software)

DBMS support: DB2 0S/390, DB2 UNIX/PC, Informix, ODBC, OLE DB, Oracle, Microsoft
SQL Server, SYBASE, Teradata

Default value: DBMS

Syntax
DBGEN_NAME=DBMS | SAS

For more information about the DBGEN_NAME-= option, see the data set options for
relational databases section in the SAS/ACCESS 9.1 for Relational Databases:
Reference.
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DBKEY= Data Set Option

Can improve performance when processing a join that involves a large DBMS table and a small
SAS data set or DBMS table (by specifying a key column to optimize DBMS retrieval)

Valid in:.  DATA and PROC steps (when accessing DBMS data using SAS/ACCESS

software)

DBMS support: DB2 0S/390, DB2 UNIX/PC, Informix, ODBC, OLE DB, Oracle, Microsoft
SQL Server, SYBASE, Teradata

Default value: none

Syntax
DBKEY=(<">column-1<’> <... <’>column-n<’>>)

For more information about the DBKEY= option, see the data set options for
relational databases section in the SAS/ACCESS 9.1 for Relational Databases:
Reference.

DBMASTER= Data Set Option

Used to designate which table is the larger table when you are processing a join that involves
tables from two different types of databases

Valid in:.  DATA and PROC steps (when accessing DBMS data using SAS/ACCESS
software)

DBMS support: DB2 0S/390, DB2 UNIX/PC, Informix, ODBC, OLE DB, Oracle, Microsoft
SQL Server, SYBASE, Teradata

Default value: none

Syntax
DBMASTER=YES

For more information about the DBMASTER= option, see the data set options for
relational databases section in the SAS/ACCESS 9.1 for Relational Databases:
Reference.
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NULLCHAR= Data Set Option

Indicates how SAS character missing values are handled during insert, update, DBINDEX=, and
DBKEY= processing

Valid in:.  DATA and PROC steps (when accessing DBMS data using SAS/ACCESS
software)

DBMS support: DB2 0S/390, DB2 UNIX/PC, Informix, ODBC, OLE DB, Oracle, Microsoft
SQL Server, SYBASE, Teradata

Default value: SAS

Syntax
NULLCHAR= SAS | YES | NO

For more information about the NULLCHAR= option, see the data set options for
relational databases section in the SAS/ACCESS 9.1 for Relational Databases:
Reference.

NULLCHARVAL= Data Set Option

Defines the character string that replaces SAS character missing values during insert, update,
DBINDEX=, and DBKEY= processing

Valid in:.  DATA and PROC steps (when accessing DBMS data using SAS/ACCESS

software)

DBMS support: DB2 0S/390, DB2 UNIX/PC, Informix, ODBC, OLE DB, Oracle, Microsoft
SQL Server, SYBASE, Teradata

Default value: a blank character

Syntax
NULLCHARVAL-="character-string’

For more information about the NULLCHARVAL= option, see the data set options
for relational databases section in the SAS/ACCESS 9.1 for Relational Databases:
Reference.
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REREAD_EXPOSURE= Data Set Option

Specifies whether the SAS/ACCESS engine behaves like a random access engine for the scope of
the LIBNAME statement
Valid in:.  SAS/ACCESS LIBNAME statement

DBMS support: DB2 0S/390, DB2 UNIX/PC, Informix, ODBC, OLE DB, Oracle,
Microsoft SQL Server, SYBASE, Teradata

Default value: NO

Syntax
REREAD_EXPOSURE= NO | YES

For more information about the REREAD_EXPOSURE= option, see the LIBNAME
statement for relational databases section in the SAS/ACCESS 9.1 for Relational
Databases: Reference.

Examples

Example 1: Accessing the SAP Server From a Local Host In this example, the RFC
server has been started on the local host on port 6998. You want to access the SAP
system on sapr3srv.sup.com. The system number for the system is 03. You specify the
entire set of user information, for example, client, user, password, and language.

libname mylib r3 user=TEST password=MYPASS client=800 language=EN
ashost=sapr3srv.sup.com sysnr=03
host=localhost port=6998;

Note: 1If the RFC server has been started on the SAS system host on port 6999, you
do not need to define the host or port because 6999 is the default. 2



100

REREAD_EXPOSURE= Data Set Option A Chapter 6

Example 2: Changing the User Logon Language In this example, the RFC server has
been started on betaguys on port 6994. You want to access the BW system on whjapp01
and the system number is 06. This time you want to log on using the German
language. If you log on using that language, the column labels will all be in German.

libname bwides r3 user=Test password=pwd client=800 language=DE
ashost=whjapp0l sysnr=06
host=betaguys port=6994;

Example 3: Defining an SAP Destination from the SAP Logon Utility In this example,
the RFC server is running on the local host on port 6999. This is the default. The SAP
system you want to access is defined as SI9 in the SAP logon utility.

libname mylib r3 user=test password=secret client=800 language=E
saplogon_id=SI9;

Example 4: Defining an SAP Destination from the saprfc.ini File In this example, the
RFC server is running on the local host on port 6999. This is the default. The SAP
system you want to access is defined by the logical destination bwides in the file
saprfc.ini.

libname mylib r3 user=test password=secret client=800 language=EN

destination=bwides;
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Recommended Reading

Recommended Reading 101

Recommended Reading

Here is the recommended reading list for this title:
0 Doing More with SAS/ASSIST
Getting Started with the SAS System
SAS/AF Procedure Guide
SAS/FSP Procedures Guide
SAS Language Reference: Concepts
SAS Language Reference: Dictionary
SAS Macro Language: Reference
SAS /Warehouse Administrator Metadata API Reference
SAS /Warehouse Administrator User’s Guide
Step-by-Step Programming with Base SAS Software
Getting Started with SAS/ASSIST
SAS Companion that is specific to your operating environment.

OO0 oooo oo o g

For a complete list of SAS publications, see the current SAS Publishing Catalog. To
order the most current publications or to receive a free copy of the catalog, contact a
SAS representative at

SAS Publishing Sales

SAS Campus Drive

Cary, NC 27513

Telephone: (800) 727-3228*

Fax: (919) 677-8166

E-mail: sasbook@sas.com

Web address: support.sas.com/pubs

* For other SAS Institute business, call (919) 677-8000.

Customers outside the United States should contact their local SAS office.
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ABAP
Advanced Business Applications Programming. ABAP is a fourth-generation
programming language that is used for developing SAP R/3 client/server applications.

Communications Interface
an interface through which various types of R/3 communication can occur. R/3
communicates with all systems that comply with Open Systems architecture. The
Communications Interface enables users to work transparently with data from any
one of several database management systems in any one of several operating
environments. The Communications Interface also enables users to run R/3 in
multiple operating environments.

CPI-C
Common Programming Interface-Communications. An application-level interface for
direct program-to-program communication. CPI-C is not used in 9.1 and later
versions of the SAS/ACCESS Interface to R/3.

data dictionary
in R/3 applications, a central repository that stores metadata about the data sources,
such as a database that contains information about company expenses and company
profits or a database that contains human resources information. The data dictionary
also stores information about the applications that use the data sources.

data model
a collection of data that is relevant to a particular facet of a specific business, such as
finance or materials management. A data model can contain other data models. A
data model is used to organize potentially complex relationships between entity types
and other data models.

DATA step
a group of statements in a SAS program that begins with a DATA statement and
ends with either a RUN statement, another DATA statement, a PROC statement, the
end of the job, or the semicolon that immediately follows lines of data. The DATA
step enables you to read raw data or other SAS data sets and to use programming
logic to create a SAS data set, to write a report, or to write to an external file.

Database Interface
in SAP R/3, a logical application layer that is used to transport data between one or
more physical databases and the R/3 applications. The R/3 Database Interface
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translates R/3 SQL statements into pure SQL statements and enables R/3 to access
data that is in other database formats.

entity
in SAP R/3 applications, an abstract or physical object, such as ”Mr. Brown” or
”Division Management Subsystem” that represents the smallest collection of data
that has meaning within a business. An entity is categorized according to its entity
type properties. See also entity type.

entity type
in R/3 applications, a category of entities that have the dame definable
characteristics. The definable characteristics are called attributes. Multiple entity
types can be grouped into a single table. See also entity.

ERP (Enterprise Resource Planning) system
an integrated application that controls day-to-day business operations such as
inventory, sales, finance, human resources, and distribution. From the warehousing
perspective, ERP systems differ from standard databases in that they have predefined
data models that must be understood in order to successfully extract the data.

format
a pattern that SAS uses to determine how the values of a variable should be written
or displayed. SAS provides a set of standard formats and also enables you to define
your own formats.

library reference
See libref.

libref
a name that is temporarily associated with a SAS data library. For example, in the
name SASUSER.ACCOUNTS, the name SASUSER is the libref. You assign a libref
with a LIBNAME statement or with an operating system’s command.

observation
a row in a SAS data set. All of the data values in an observation are associated with
a single entity such as a customer or a state. Each observation contains one data
value for each variable.

ODD
an operational data definition. A metadata record that provides access to a data
source. ODDs are used for loading data into data stores in your warehouse.

PROC step
a group of SAS statements that call and execute a procedure. A PROC step usually
takes a SAS data set as input.

R/3
an enterprise resource planning (ERP) system that has been developed by SAP AG
for use in client/server environments.

RFC
Remote Function Call. The RFC is the SAP AG implementation of a remote
procedure call. RFCs enable external applications such as SAS and R/3 systems to
access SAP BW and R/3 systems.

SAS data library
a collection of one or more SAS files that are recognized by SAS and that are
referenced and stored as a unit. Each file is a member of the library.
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SAS data set
a file whose contents are in one of the native SAS file formats. There are two types of
SAS data sets: SAS data files and SAS data views. SAS data files contain data
values in addition to descriptor information that is associated with the data. SAS
data views contain only the descriptor information plus other information that is
required for retrieving data values from other SAS data sets or from files whose
contents are in other software vendors’ file formats.

sideinfo file
a text file that can be used to set logon parameters, such as RFC host, system
number, gateway service, and gateway host, for R/3 users.

variable
a column in a SAS data set. Each column contains data values that describe a single
characteristic for all observations.

view
a definition of a virtual data set. The definition is named and stored for later use. A
view contains no data; it merely describes or defines data that is stored elsewhere.
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ABAP Function module
name specification
ABAP function modules and programs
RFC server
ABAP Open SQL
number of tables
ABAP program name
RFC server
ABAP Report module
ABAP type NUMC
SAS type for
ABAP Where Expression Builder window @
ABAPFM-= option
LIBNAME statement for SAP
ABAPPROG= option
LIBNAME statement for SAP
Advanced Parameters window
General tab
REC tab
sideinfo file
TCP/IP tab
All Entity Types tab
Application Setup window
Data Dictionary tab
Defaults tab
Miscellaneous tab
ASHOST= option
LIBNAME statement for SAP
Assigned Tables tab
Attributes for a Table (Edit) window
Fields tab
General Attributes tab
Related Tables tab
Select Fields for a Table window

Where tab |44
Attributes tab

BAPI connection parameters
BATCH= data set option

batch jobs
for data extracts
batch mode

RFC server in
batch operations

passwords

source parameter

BATCH= option
LIBNAME statement for SAP

C

%CALLREC macro
catalog entries
CLIENT= option
LIBNAME statement for SAP
code page
connecting to R/3 systems
CONNECTION= option
LIBNAME statement for SAP
connection parameters
CONNECTION_GROUP= option
LIBNAME statement for SAP
Connections menu
Datamodel Explorer window
Logon to R/3 window
Create Extract Programs window

data access methods
direct access
extract management method

ODBC
parameters for
R/3

Remote Function Call (RFC)
data dictionary
local copy of
location of
search facility
Data Dictionary Search Facility window
Options tab
Search String tab
Data Dictionary tab
data extracts
batch mode
data models
entity types for
data set options
for SAP engine
data sets
creating or selecting
Datamodel Explorer
ABAP Where Expression Builder window @I
Attributes for a Table (Edit) window
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Create Extract Programs window @ to SAS/Warehouse Administrator ﬂ
Enter Catalog Entry Name window extract management method
Enter Dataset Name window data transfer and use
General Attributes for a List of Tables window installation and setup
List of Connections window extract programs
starting creating  [40]
Datamodel Explorer window extracted rows
All Entity Types tab querying

Assigned Tables tab
Attributes tab

Connections menu F

File menu Fields tab

menus File menu

Sub Data Models tab Datamodel Explorer window
DBCONDITION= data set option Logon to R/3 window
DBGEN_NAME-= data set option floating point numbers
DBGEN_NAME-= option functions

LIBNAME statement for SAP calling R/3 function modules
DBKEY= data set option for logon
DBMASTER= data set option
DBMS

passing generated SQL to G
DBMS columns

General Attributes for a List of Tables window
General Attributes tab
General tab

labels
renaming

DBMS connections Advanced Parameters window
p.ro.mpts for. List of Connections window
timing of generated SQL

DBMS dé.ita _ passing to DBMS
subsetting and ordering GROUP= option

DBLI;EOX[;T; option for SAP LIBNAME statement for SAP
N statement for GWHOST= option

DBLSIQEIX;?Eb opuonf ap LIBNAME statement for SAP
statement for GWSERV= option

Defaults tab 4 LIBNAME statement for SAP
DEFER= option

LIBNAME statement for SAP

descriptor library H
descriptors

creating hosf name

for list of tables for message server

list of of SAP application server
DESTINATION= option of SAP gateway

HOST= option

LIBNAME statement for SAP |82
B2 LIBNAME statement for SAP

direct access method
DIRECT_SQL= option

LIBNAME statement for SAP
disconnecting from R/3 systems

IEEE_REVERSE-= option
LIBNAME statement for SAP
E INENCODING= option
LIBNAME statement for SAP
IP address
of SAP application server

encrypted password

for SAP logon parameter
engine options

LIBNAME statement for SAP

Enter Catalog Entry Name window J

Enter Dataset Name window

entity types Joins
Assigned Tables tab number of tables
attributes of performance and
for data models table size

Export Metadata to SAS/Warehouse Administrator win-
dow @ L
Export Metadata window
exporting metadata LANGUAGE-= option
parameters for LIBNAME statement for SAP
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engine options
examples
LIBNAME options
syntax
libraries
local copy of data dictionary
location of data dictionary
List of Connections window
General tab
More RFC tab
REC tab
TCP/IP tab
List of Descriptors

Export Metadata to SAS/Warehouse Administrator win-

dow
Export Metadata window
List of R/3 Descriptors window
List of R/3 Descriptors window
List of R/3 Tables window
local setup utility
Application Setup window
logon function
logon parameter client
logon parameters
Logon to R/3 window E,
Connections menu
File menu
logon utility
Advanced Parameters window
Logon to R/3 window
Logon window
R/3 BAPI Connector

macro variables
for RFC
RFC_LOGON_INFO
macros
%CALLREC
for RFC
%R3CONNB
%R3CONNC
%R3CONNE
MAX_TABLE_JOINS= option
LIBNAME statement for SAP
menus
Datamodel Explorer window
Logon to R/3 window
message server
host name
metadata
exporting to SAS/Warehouse Administrator ﬂ,
parameters for exporting
searching EI,
storage for
Miscellaneous tab
missing values
More RFC tab
MSHOST= option
LIBNAME statement for SAP
MULTI_DATASRC_OPT= option
LIBNAME statement for SAP

NULLCHAR= data set option

NULLCHARVAL= data set option

NUMC_SAS_TYPE= option
LIBNAME statement for SAP

0

observations
number to display
ODBC (Open Data Base Connectivity)
Options tab
ordering DBMS data

P

PASSWORD= option

LIBNAME statement for SAP
passwords

for batch operations

SAP logon parameter |36}

SAP logon parameter, encrypted form
PASSWORDX= option

LIBNAME statement for SAP
performance

joins and
PORT= option

LIBNAME statement for SAP
profiles

connecting/disconnecting with

creating [
displaying
predefined E
text descriptions of
text labels for

Q

queries
creating in ABAP syntax @
of extracted rows
parameters for

R
R3 B[ig

accessing data with
connecting to R/3 systems
disconnecting from R/3 systems

getting started with

starting

system name

system number
R/3 BAPI Connector: Logon window
%R3CONNB macro
%R3CONNC macro
%R3CONNE macro
R3NAME= option

LIBNAME statement for SAP
random access engine

SAS/ACCESS engine as
read transactions

utility spool file
Related Tables tab [44]
Remote Function Call (RFC)
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remote SAS sessions SAS sessions
REREAD_EXPOSURE= data set option remote
REREAD_EXPOSURE-= option SAS/Warehouse Administrator
LIBNAME statement for SAP exporting metadata to  [7}
RFC (Remote Function Call) Search Metadata utility
RFC server Data Dictionary Search Facility window
ABAP Function module name Search String tab
ABAP function modules and programs searching metadata EI,
ABAP program name Select Fields for a Table window
batch jobs for data extracts setup
batch mode Application Setup window
host for connecting to SAP local setup utility
macros and macro variables sideinfo file
network location of source entry
on UNIX source library
on Windows NT source parameter
port number SPOOL= option
R/3 BAPI Connector: Logon window LIBNAME statement for SAP
tracing requests SQL
RFC tab number of tables in joins
Advanced Parameters window passing generated SQL to DBMS
List of Connections window Sub Data Models tab
RFC_LOGON_INFO macro variable subsetting DBMS data
RfcOpenEx() call SYSNR= option
additional logon or connection parameters LIBNAME statement for SAP
RFC_STRING= option system name
LIBNAME statement for SAP system number
rows
querying extracted rows T
S tables
Assigned Tables tab
SAP application servers attributes for
group name of fields
host name or IP address list of
SAP destination number of tables in joins
defining from SAP logon utility [100 querying extracted rows
defining from saprfc.ini file |100| related tables
SAP engine size of, for joins
data set options for TCP/IP tab
SAP gateway Advanced Parameters window
host name of List of Connections window
service of Tools menu
SAP LIBNAME Engine TRACE= option
SAP logon parameter LIBNAME statement for SAP
client transport files
language for tutorial 3
password
password, encrypted form U
user name |89
SAP logon utility UNIX
defining SAP destination from |[100] RFC server on
SAP server user logon language
accessing from local host changing [100]
SAP transport files USER= option
SAPLOGON LIBNAME statement for SAP
string defined for utility spool file
SAPLOGON_ID= option for read transactions
LIBNAME statement for SAP
saprfc.ini file Vv
defining SAP destination from |100
destination indication View menu
SAS/ACCESS engine views
as random access engine creating
SAS/ACCESS Interface to R/3 default settings

See R/3 for list of tables
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w Where tab

WHERE expressions Windows NT
creating in ABAP syntax @ REC server on






Your Turn

If you have comments or suggestions about SAS/ACCESS® 4.2 Interface to R/3: User’s
Guide, please send them to us on a photocopy of this page, or send us electronic mail.

For comments about this book, please return the photocopy to

SAS Publishing
SAS Campus Drive
Cary, NC 27513

E-mail: yourturn@sas.com

For suggestions about the software, please return the photocopy to

SAS Institute Inc.
Technical Support Division
SAS Campus Drive

Cary, NC 27513

E-mail: suggest@sas.com
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